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The Quick Start Guide describes the following R&S®OSP models and options: 

● R&S® OSP 120, stock no. 1505.3009.02/.12 
● R&S® OSP 130, stock no. 1505.3009.03 
● R&S® OSP 150, stock no. 1505.3009.05 
● Option Module R&S® OSP-B011, stock no. 1505.4763.02 
● Option Module R&S® OSP-B012, stock no. 1505.4770.02 
● Option Module R&S® OSP-B101, stock no. 1505.5101.02 
● Option Module R&S® OSP-B102, stock no. 1505.5201.02 
● Option Module R&S® OSP-B103, stock no. 1505.5301.02 
● Option Module R&S® OSP-B104, stock no. 1505.5401.02 
● Option Module R&S® OSP-B106, stock no. 1505.5601.02 
● Option Module R&S® OSP-B107, stock no. 1505.5901.02 
● Option Module R&S® OSP-B108, stock no. 1505.5718.02 
● Option Module R&S® OSP-B111, stock no. 1505.4605.02 
● Option Module R&S® OSP-B112, stock no. 1505.4611.02 
● Option Module R&S® OSP-B114, stock no. 1505.4711.02 
● Option Module R&S® OSP-B121, stock no. 1505.5504.02 
● Option Module R&S® OSP-B122, stock no. 1505.5510.02 
● Option Module R&S® OSP-B123, stock no. 1505.5527.02 
● Option Module R&S® OSP-B124, stock no. 1505.5533.02 
● Option Module R&S® OSP-B125, stock no. 1505.5540.02 
● Option Module R&S® OSP-B126, stock no. 1505.5556.02 
● Option Module R&S® OSP-B127, stock no. 1505.4728.02 
● Option Module R&S® OSP-B128, stock no. 1505.4734.11/.12/.13 
● Option Module R&S® OSP-B129, stock no. 1515.5556.02 
● Option Module R&S® OSP-B131 stock no. 1505.4740.02 
● Option Module R&S® OSP-B132, stock no. 1515.4757.02 

The firmware of the instrument makes use of several valuable open source software packages. the most important of them are listed 
below, together with their corresponding open source license. The verbatimlicense texts are provided on the user documentation CD-
ROM (included in delivery). 

Package Link License 
LINUX® Kernel http://www.linux.org/ GPL 2 

gLibc http://www.gnu.org/software/libc/ LGPL 

busybox http://www.busybox.net/ GPL 2 

OpenSSL http://www.openssl.org/ OpenSSL / SSLeay 

X.org http://www.x.org/ X.org 

Xitami http://www.xitami.com NetSnmp-5.0.8 

PHP http://www.php.net 2.5b6 

OpenSSL http://www.openssl.org BSD  

BOOST Library http://www.boost.org Artistic  

zlib http://www.zlib.net Boost Software, v.1 

PC/SC-Lite http://www.linuxnet.com/ ACE_TAO 
 
The OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/). includes cryptographic software written by Eric 
Young (eay@cryptsoft.com) and software written by Tim Hudson (tjh@cryptsoft.com). 
 
LINUX® is a trademark of Linus Torvalds. 
 
Rohde&Schwarz would like to thank the open source community for their valuable contribution to embedded computing. 
 
© 2008 Rohde & Schwarz GmbH & Co. KG 
81671 Munich, Germany 
Printed in Germany – Subject to change – Data without tolerance limits is not binding. 
R&S® is a registered trademark of Rohde & Schwarz GmbH & Co. KG. 
Trade names are trademarks of the owners. 
 
The following abbreviations are used throughout this manual: 
R&S®OSP is abbreviated as R&S OSP. 

http://www.openssl.org/).


1171.0000.42 - 06 Page 1 

Basic Safety Instructions 
Always read through and comply with the following safety instructions! 

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety 
standards of our products up to date and to offer our customers the highest possible degree of safety. Our 
products and the auxiliary equipment they require are designed, built and tested in accordance with the 
safety standards that apply in each case. Compliance with these standards is continuously monitored by 
our quality assurance system. The product described here has been designed, built and tested in 
accordance with the attached EC Certificate of Conformity and has left the manufacturer’s plant in a 
condition fully complying with safety standards. To maintain this condition and to ensure safe operation, 
you must observe all instructions and warnings provided in this manual. If you have any questions 
regarding these safety instructions, the Rohde & Schwarz group of companies will be happy to answer 
them. 

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed 
for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must 
not be used in any way that may cause personal injury or property damage. You are responsible if the 
product is used for any purpose other than its designated purpose or in disregard of the manufacturer's 
instructions. The manufacturer shall assume no responsibility for such use of the product.  

The product is used for its designated purpose if it is used in accordance with its product documentation 
and within its performance limits (see data sheet, documentation, the following safety instructions). Using 
the product requires technical skills and, in some cases, a basic knowledge of English. It is therefore 
essential that only skilled and specialized staff or thoroughly trained personnel with the required skills be 
allowed to use the product. If personal safety gear is required for using Rohde & Schwarz products, this 
will be indicated at the appropriate place in the product documentation. Keep the basic safety instructions 
and the product documentation in a safe place and pass them on to the subsequent users. 

Observing the safety instructions will help prevent personal injury or damage of any kind caused by 
dangerous situations. Therefore, carefully read through and adhere to the following safety instructions 
before and when using the product. It is also absolutely essential to observe the additional safety 
instructions on personal safety, for example, that appear in relevant parts of the product documentation. In 
these safety instructions, the word "product" refers to all merchandise sold and distributed by the Rohde & 
Schwarz group of companies, including instruments, systems and all accessories. For product-specific 
information, see the data sheet and the product documentation. 

Symbols and safety labels 

Symbol Meaning Symbol Meaning 

Notice, general danger location 

Observe product documentation 

ON/OFF supply voltage 

Caution when handling heavy equipment Standby indication 

Danger of electric shock Direct current (DC) 
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Symbol Meaning Symbol Meaning 

Warning! Hot surface Alternating current (AC) 

Protective conductor terminal Direct/alternating current (DC/AC) 

Ground Device fully protected by double (reinforced) 
insulation 

Ground terminal EU labeling for batteries and accumulators 

For additional information, see section "Waste 
disposal/Environmental protection", item 1. 

Be careful when handling electrostatic sensitive 
devices 

EU labeling for separate collection of electrical 
and electronic devices 

For additonal information, see section "Waste 
disposal/Environmental protection", item 2. 

Warning! Laser radiation 

For additional information, see section 
"Operation", item 7. 

 

Signal words and their meaning 

The following signal words are used in the product documentation in order to warn the reader about risks 
and dangers. 

Indicates an imminently hazardous situation which, if not avoided, will result 
in death or serious injury. 

Indicates a potentially hazardous situation which, if not avoided, could result 
in death or serious injury. 

Indicates a potentially hazardous situation which, if not avoided, could result 
in minor or moderate injury. 

Indicates the possibility of incorrect operation which can result in damage to 
the product.  
In the product documentation, the word ATTENTION is used synonymously.  

 
These signal words are in accordance with the standard definition for civil applications in the European 
Economic Area. Definitions that deviate from the standard definition may also exist in other economic 
areas or military applications. It is therefore essential to make sure that the signal words described here 
are always used only in connection with the related product documentation and the related product. The 
use of signal words in connection with unrelated products or documentation can result in misinterpretation 
and in personal injury or material damage. 
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Operating states and operating positions 

The product may be operated only under the operating conditions and in the positions specified by the 
manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are 
not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local 
or national safety regulations and rules for the prevention of accidents must be observed in all work 
performed.  

1. Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:  
predefined operating position is always with the housing floor facing down, IP protection 2X, use only 
indoors, max. operating altitude 2000 m above sea level, max. transport altitude 4500 m above sea 
level. A tolerance of ±10 % shall apply to the nominal voltage and ±5 % to the nominal frequency, 
overvoltage category 2, pollution severity 2. 

2. Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability 
are unsuitable for this purpose. Always follow the manufacturer's installation instructions when 
installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation 
that is not carried out as described in the product documentation could result in personal injury or 
even death. 

3. Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient 
temperature must not exceed the maximum temperature specified in the product documentation or in 
the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or 
even death. 

Electrical safety 

If the information on electrical safety is not observed either at all or to the extent necessary, electric shock, 
fire and/or serious personal injury or death may occur.  

1. Prior to switching on the product, always ensure that the nominal voltage setting on the product 
matches the nominal voltage of the AC supply network. If a different voltage is to be set, the power 
fuse of the product may have to be changed accordingly.  

2. In the case of products of safety class I with movable power cord and connector, operation is 
permitted only on sockets with a protective conductor contact and protective conductor. 

3. Intentionally breaking the protective conductor either in the feed line or in the product itself is not 
permitted. Doing so can result in the danger of an electric shock from the product. If extension cords 
or connector strips are implemented, they must be checked on a regular basis to ensure that they are 
safe to use. 

4. If there is no power switch for disconnecting the product from the AC supply network, or if the power 
switch is not suitable for this purpose, use the plug of the connecting cable to disconnect the product 
from the AC supply network. In such cases, always ensure that the power plug is easily reachable and 
accessible at all times. For example, if the power plug is the disconnecting device, the length of the 
connecting cable must not exceed 3 m. Functional or electronic switches are not suitable for providing 
disconnection from the AC supply network. If products without power switches are integrated into 
racks or systems, the disconnecting device must be provided at the system level. 

5. Never use the product if the power cable is damaged. Check the power cables on a regular basis to 
ensure that they are in proper operating condition. By taking appropriate safety measures and 
carefully laying the power cable, ensure that the cable cannot be damaged and that no one can be 
hurt by, for example, tripping over the cable or suffering an electric shock.  
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6. The product may be operated only from TN/TT supply networks fuse-protected with max. 16 A (higher 
fuse only after consulting with the Rohde & Schwarz group of companies). 

7. Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the 
socket provided for this purpose. Otherwise, sparks that result in fire and/or injuries may occur.  

8. Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric 
shocks. 

9. For measurements in circuits with voltages Vrms > 30 V, suitable measures (e.g. appropriate 
measuring equipment, fuse protection, current limiting, electrical separation, insulation) should be 
taken to avoid any hazards. 

10. Ensure that the connections with information technology equipment, e.g. PCs or other industrial 
computers, comply with the IEC60950-1/EN60950-1 or IEC61010-1/EN 61010-1 standards that apply 
in each case. 

11. Unless expressly permitted, never remove the cover or any part of the housing while the product is in 
operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the 
product. 

12. If a product is to be permanently installed, the connection between the protective conductor terminal 
on site and the product's protective conductor must be made first before any other connection is 
made. The product may be installed and connected only by a licensed electrician. 

13. For permanently installed equipment without built-in fuses, circuit breakers or similar protective 
devices, the supply circuit must be fuse-protected in such a way that anyone who has access to the 
product, as well as the product itself, is adequately protected from injury or damage. 

14. Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of 
lightning) can reach the product. Otherwise, the person operating the product will be exposed to the 
danger of an electric shock. 

15. Any object that is not designed to be placed in the openings of the housing must not be used for this 
purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries. 

16. Unless specified otherwise, products are not liquid-proof (see also section "Operating states and 
operating positions", item 1). Therefore, the equipment must be protected against penetration by 
liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product 
itself may be damaged, which can also lead to personal injury. 

17. Never use the product under conditions in which condensation has formed or can form in or on the 
product, e.g. if the product has been moved from a cold to a warm environment. Penetration by water 
increases the risk of electric shock. 

18. Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network 
or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such 
as alcohol, acetone or diluents for cellulose lacquers. 

Operation 

1. Operating the products requires special training and intense concentration. Make sure that persons 
who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries 
or material damage may occur. It is the responsibility of the employer/operator to select suitable 
personnel for operating the products. 
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2. Before you move or transport the product, read and observe the section titled "Transport". 

3. As with all industrially manufactured goods, the use of substances that induce an allergic reaction 
(allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a 
skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz 
product, consult a physician immediately to determine the cause and to prevent health problems or 
stress.  

4. Before you start processing the product mechanically and/or thermally, or before you take it apart, be 
sure to read and pay special attention to the section titled "Waste disposal/Environmental protection", 
item 1. 

5. Depending on the function, certain products such as RF radio equipment can produce an elevated 
level of electromagnetic radiation. Considering that unborn babies require increased protection, 
pregnant women must be protected by appropriate measures. Persons with pacemakers may also be 
exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces 
where there is a special risk of exposure to radiation and, if necessary, take measures to avert the 
potential danger. 

6. Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can 
cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and 
protective clothing must be worn. 

7. Laser products are given warning labels that are standardized according to their laser class. Lasers 
can cause biological harm due to the properties of their radiation and due to their extremely 
concentrated electromagnetic power. If a laser product (e.g. a CD/DVD drive) is integrated into a 
Rohde & Schwarz product, absolutely no other settings or functions may be used as described in the 
product documentation. The objective is to prevent personal injury (e.g. due to laser beams). 

8. EMC classes (in line with CISPR 11) 
Class A: Equipment suitable for use in all environments except residential environments and 
environments that are directly connected to a low-voltage supply network that supplies residential 
buildings. 
Class B: Equipment suitable for use in residential environments and environments that are directly 
connected to a low-voltage supply network that supplies residential buildings. 

Repair and service 

1. The product may be opened only by authorized, specially trained personnel. Before any work is 
performed on the product or before the product is opened, it must be disconnected from the AC supply 
network. Otherwise, personnel will be exposed to the risk of an electric shock.  

2. Adjustments, replacement of parts, maintenance and repair may be performed only by electrical 
experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant 
to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed 
after parts relevant to safety have been replaced (visual inspection, protective conductor test, 
insulation resistance measurement, leakage current measurement, functional test). This helps ensure 
the continued safety of the product.  
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Batteries and rechargeable batteries/cells 

If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the 
extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal 
injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g. 
lithium cells) must be handled in accordance with the EN 62133 standard. 

1. Cells must not be taken apart or crushed.  

2. Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided. 
Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth. 

3. Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box or in a 
drawer where they can short-circuit each other, or where they can be short-circuited by other 
conductive materials. Cells and batteries must not be removed from their original packaging until they 
are ready to be used. 

4. Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted. 

5. If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If 
contact occurs, wash the affected area with plenty of water and seek medical aid. 

6. Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells) 
can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see 
parts list) in order to ensure the safety of the product.  

7. Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries 
and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the 
national regulations regarding waste disposal and recycling.  

Transport 

1. The product may be very heavy. Therefore, the product must be handled with care. In some cases, 
the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid 
back or other physical injuries.  

2. Handles on the products are designed exclusively to enable personnel to transport the product. It is 
therefore not permissible to use handles to fasten the product to or on transport equipment such as 
cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the 
means of transport or lifting. Observe the safety regulations of the manufacturer of the means of 
transport or lifting. Noncompliance can result in personal injury or material damage. 

3. If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely 
and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the 
product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the 
product in the vehicle to prevent injuries or other damage in the event of an accident.  

Waste disposal/Environmental protection 

1. Specially marked equipment has a battery or accumulator that must not be disposed of with unsorted 
municipal waste, but must be collected separately. It may only be disposed of at a suitable collection 
point or via a Rohde & Schwarz customer service center. 
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2. Waste electrical and electronic equipment must not be disposed of with unsorted municipal waste, but 
must be collected separately. 
Rohde & Schwarz GmbH & Co. KG has developed a disposal concept and takes full responsibility for 
take-back obligations and disposal obligations for manufacturers within the EU. Contact your 
Rohde & Schwarz customer service center for environmentally responsible disposal of the product. 

3. If products or their components are mechanically and/or thermally processed in a manner that goes 
beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel) 
may be released. For this reason, the product may only be disassembled by specially trained 
personnel. Improper disassembly may be hazardous to your health. National waste disposal 
regulations must be observed.  

4. If handling the product releases hazardous substances or fuels that must be disposed of in a special 
way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the 
manufacturer of the hazardous substances or fuels and the applicable regional waste disposal 
regulations must be observed. Also observe the relevant safety instructions in the product 
documentation. The improper disposal of hazardous substances or fuels can cause health problems 
and lead to environmental damage. 

For additional information about environmental protection, visit the Rohde & Schwarz website. 

Instrucciones de seguridad elementales 
¡Es imprescindible leer y cumplir las siguientes instrucciones e informaciones de seguridad! 

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al día 
con los estándares de seguridad y de ofrecer a nuestros clientes el máximo grado de seguridad. Nuestros 
productos y todos los equipos adicionales son siempre fabricados y examinados según las normas de 
seguridad vigentes. Nuestro sistema de garantía de calidad controla constantemente que sean cumplidas 
estas normas. El presente producto ha sido fabricado y examinado según el certificado de conformidad 
adjunto de la UE y ha salido de nuestra planta en estado impecable según los estándares técnicos de 
seguridad. Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario 
deberá atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de 
empresas Rohde & Schwarz está siempre a su disposición en caso de que tengan preguntas referentes a 
estas informaciones de seguridad. 

Además queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto 
está destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente 
autorizado, para aplicaciones de campo y de ninguna manera deberá ser utilizado de modo que alguna 
persona/cosa pueda sufrir daño. El uso del producto fuera de sus fines definidos o sin tener en cuenta las 
instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna 
forma responsable de consecuencias a causa del mal uso del producto.  
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Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las 
indicaciones de la correspondiente documentación del producto y dentro del margen de rendimiento 
definido (ver hoja de datos, documentación, informaciones de seguridad que siguen). El uso del producto 
hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener 
en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en 
profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el 
uso de productos de Rohde & Schwarz, encontraría la información debida en la documentación del 
producto en el capítulo correspondiente. Guarde bien las informaciones de seguridad elementales, así 
como la documentación del producto, y entréguelas a usuarios posteriores. 

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o daños por 
peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las 
siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del 
producto. Deberán tenerse en cuenta todas las demás informaciones de seguridad, como p. ej. las 
referentes a la protección de personas, que encontrarán en el capítulo correspondiente de la 
documentación del producto y que también son de obligado cumplimiento. En las presentes 
informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas 
Rohde & Schwarz bajo la denominación de "producto", entre ellos también aparatos, instalaciones así 
como toda clase de accesorios. Los datos específicos del producto figuran en la hoja de datos y en la 
documentación del producto. 

Símbolos y definiciones de seguridad 

Símbolo Significado Símbolo Significado 

Aviso: punto de peligro general 

Observar la documentación del producto 

Tensión de alimentación de PUESTA EN 
MARCHA / PARADA 

Atención en el manejo de dispositivos de peso 
elevado 

Indicación de estado de espera (standby) 

Peligro de choque eléctrico Corriente continua (DC) 

Advertencia: superficie caliente Corriente alterna (AC) 

Conexión a conductor de protección Corriente continua / Corriente alterna (DC/AC) 

Conexión a tierra El aparato está protegido en su totalidad por un 
aislamiento doble (reforzado) 

Conexión a masa Distintivo de la UE para baterías y 
acumuladores 

Más información en la sección 
"Eliminación/protección del medio ambiente", 
punto 1. 
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Símbolo Significado Símbolo Significado 

Aviso: Cuidado en el manejo de dispositivos 
sensibles a la electrostática (ESD) 

Distintivo de la UE para la eliminación por 
separado de dispositivos eléctricos y 
electrónicos 

Más información en la sección 
"Eliminación/protección del medio ambiente", 
punto 2. 

Advertencia: rayo láser 

Más información en la sección 
"Funcionamiento", punto 7. 

 

Palabras de señal y su significado 

En la documentación del producto se utilizan las siguientes palabras de señal con el fin de advertir contra 
riesgos y peligros. 

PELIGRO identifica un peligro inminente con riesgo elevado que 
provocará muerte o lesiones graves si no se evita.  

ADVERTENCIA identifica un posible peligro con riesgo medio de 
provocar muerte o lesiones (graves) si no se evita. 

ATENCIÓN identifica un peligro con riesgo reducido de provocar 
lesiones leves o moderadas si no se evita. 

AVISO indica la posibilidad de utilizar mal el producto y, como 
consecuencia, dañarlo. 
En la documentación del producto se emplea de forma sinónima el 
término CUIDADO. 

 
Las palabras de señal corresponden a la definición habitual para aplicaciones civiles en el área 
económica europea. Pueden existir definiciones diferentes a esta definición en otras áreas económicas o 
en aplicaciones militares. Por eso se deberá tener en cuenta que las palabras de señal aquí descritas 
sean utilizadas siempre solamente en combinación con la correspondiente documentación del producto y 
solamente en combinación con el producto correspondiente. La utilización de las palabras de señal en 
combinación con productos o documentaciones que no les correspondan puede llevar a interpretaciones 
equivocadas y tener por consecuencia daños en personas u objetos. 

Estados operativos y posiciones de funcionamiento 

El producto solamente debe ser utilizado según lo indicado por el fabricante respecto a los estados 
operativos y posiciones de funcionamiento sin que se obstruya la ventilación. Si no se siguen las 
indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con 
posible consecuencia de muerte. En todos los trabajos deberán ser tenidas en cuenta las normas 
nacionales y locales de seguridad del trabajo y de prevención de accidentes.  
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1. Si no se convino de otra manera, es para los productos Rohde & Schwarz válido lo que sigue:  
como posición de funcionamiento se define por principio la posición con el suelo de la caja para 
abajo, modo de protección IP 2X, uso solamente en estancias interiores, utilización hasta 2000 m 
sobre el nivel del mar, transporte hasta 4500 m sobre el nivel del mar. Se aplicará una tolerancia de 
±10 % sobre el voltaje nominal y de ±5 % sobre la frecuencia nominal. Categoría de sobrecarga 
eléctrica 2, índice de suciedad 2.  

2. No sitúe el producto encima de superficies, vehículos, estantes o mesas, que por sus características 
de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalación del 
fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si 
se realiza la instalación de modo distinto al indicado en la documentación del producto, se pueden 
causar lesiones o, en determinadas circunstancias, incluso la muerte. 

3. No ponga el producto sobre aparatos que generen calor (p. ej. radiadores o calefactores). La 
temperatura ambiente no debe superar la temperatura máxima especificada en la documentación del 
producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse 
choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte. 

Seguridad eléctrica 

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad 
eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia 
de muerte.  

1. Antes de la puesta en marcha del producto se deberá comprobar siempre que la tensión 
preseleccionada en el producto coincida con la de la red de alimentación eléctrica. Si es necesario 
modificar el ajuste de tensión, también se deberán cambiar en caso dado los fusibles 
correspondientes del producto.  

2. Los productos de la clase de protección I con alimentación móvil y enchufe individual solamente 
podrán enchufarse a tomas de corriente con contacto de seguridad y con conductor de protección 
conectado. 

3. Queda prohibida la interrupción intencionada del conductor de protección, tanto en la toma de 
corriente como en el mismo producto. La interrupción puede tener como consecuencia el riesgo de 
que el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de 
enchufe, deberá garantizarse la realización de un examen regular de los mismos en cuanto a su 
estado técnico de seguridad. 

4. Si el producto no está equipado con un interruptor para desconectarlo de la red, o bien si el 
interruptor existente no resulta apropiado para la desconexión de la red, el enchufe del cable de 
conexión se deberá considerar como un dispositivo de desconexión.  
El dispositivo de desconexión se debe poder alcanzar fácilmente y debe estar siempre bien accesible. 
Si, p. ej., el enchufe de conexión a la red es el dispositivo de desconexión, la longitud del cable de 
conexión no debe superar 3 m).  
Los interruptores selectores o electrónicos no son aptos para el corte de la red eléctrica. Si se 
integran productos sin interruptor en bastidores o instalaciones, se deberá colocar el interruptor en el 
nivel de la instalación. 

5. No utilice nunca el producto si está dañado el cable de conexión a red. Compruebe regularmente el 
correcto estado de los cables de conexión a red. Asegúrese, mediante las medidas de protección y 
de instalación adecuadas, de que el cable de conexión a red no pueda ser dañado o de que nadie 
pueda ser dañado por él, p. ej. al tropezar o por un choque eléctrico.  
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6. Solamente está permitido el funcionamiento en redes de alimentación TN/TT aseguradas con fusibles 
de 16 A como máximo (utilización de fusibles de mayor amperaje solo previa consulta con el grupo de 
empresas Rohde & Schwarz). 

7. Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por 
completo y fuertemente en la toma de corriente. La no observación de estas medidas puede provocar 
chispas, fuego y/o lesiones. 

8. No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto 
podría causar fuego o choques eléctricos. 

9. En las mediciones en circuitos de corriente con una tensión Ueff > 30 V se deberán tomar las medidas 
apropiadas para impedir cualquier peligro (p. ej. medios de medición adecuados, seguros, limitación 
de tensión, corte protector, aislamiento etc.). 

10. Para la conexión con dispositivos informáticos como un PC o un ordenador industrial, debe 
comprobarse que éstos cumplan los estándares IEC60950-1/EN60950-1 o IEC61010-1/EN 61010-1 
válidos en cada caso. 

11. A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa 
mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y 
puede causar lesiones, fuego o daños en el producto. 

12. Si un producto se instala en un lugar fijo, se deberá primero conectar el conductor de protección fijo 
con el conductor de protección del producto antes de hacer cualquier otra conexión. La instalación y 
la conexión deberán ser efectuadas por un electricista especializado. 

13. En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automático ni otros 
mecanismos de seguridad similares, el circuito de alimentación debe estar protegido de modo que 
todas las personas que puedan acceder al producto, así como el producto mismo, estén a salvo de 
posibles daños. 

14. Todo producto debe estar protegido contra sobretensión (debida p. ej. a una caída del rayo) mediante 
los correspondientes sistemas de protección. Si no, el personal que lo utilice quedará expuesto al 
peligro de choque eléctrico. 

15. No debe introducirse en los orificios de la caja del aparato ningún objeto que no esté destinado a ello. 
Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o 
lesiones. 

16. Salvo indicación contraria, los productos no están impermeabilizados (ver también el capítulo 
"Estados operativos y posiciones de funcionamiento", punto 1). Por eso es necesario tomar las 
medidas necesarias para evitar la entrada de líquidos. En caso contrario, existe peligro de choque 
eléctrico para el usuario o de daños en el producto, que también pueden redundar en peligro para las 
personas. 

17. No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido 
condensaciones sobre el producto o en el interior de éste, como p. ej. al desplazarlo de un lugar frío a 
otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico. 

18. Antes de la limpieza, desconecte por completo el producto de la alimentación de tensión (p. ej. red de 
alimentación o batería). Realice la limpieza de los aparatos con un paño suave, que no se deshilache. 
No utilice bajo ningún concepto productos de limpieza químicos como alcohol, acetona o diluyentes 
para lacas nitrocelulósicas. 
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Funcionamiento 

1. El uso del producto requiere instrucciones especiales y una alta concentración durante el manejo. 
Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos 
necesarios en cuanto a aptitudes físicas, psíquicas y emocionales, ya que de otra manera no se 
pueden excluir lesiones o daños de objetos. El empresario u operador es responsable de seleccionar 
el personal usuario apto para el manejo del producto. 

2. Antes de desplazar o transportar el producto, lea y tenga en cuenta el capítulo "Transporte". 

3. Como con todo producto de fabricación industrial no puede quedar excluida en general la posibilidad 
de que se produzcan alergias provocadas por algunos materiales empleados ―los llamados 
alérgenos (p. ej. el níquel)―. Si durante el manejo de productos Rohde & Schwarz se producen 
reacciones alérgicas, como p. ej. irritaciones cutáneas, estornudos continuos, enrojecimiento de la 
conjuntiva o dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las 
causas y evitar cualquier molestia o daño a la salud.  

4. Antes de la manipulación mecánica y/o térmica o el desmontaje del producto, debe tenerse en cuenta 
imprescindiblemente el capítulo "Eliminación/protección del medio ambiente", punto 1. 

5. Ciertos productos, como p. ej. las instalaciones de radiocomunicación RF, pueden a causa de su 
función natural, emitir una radiación electromagnética aumentada. Deben tomarse todas las medidas 
necesarias para la protección de las mujeres embarazadas. También las personas con marcapasos 
pueden correr peligro a causa de la radiación electromagnética. El empresario/operador tiene la 
obligación de evaluar y señalizar las áreas de trabajo en las que exista un riesgo elevado de 
exposición a radiaciones. 

6. Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias tóxicas 
(gases, líquidos etc.) que pueden generar daños a la salud. Por eso, en caso de incendio deben 
usarse medidas adecuadas, como p. ej. máscaras antigás e indumentaria de protección. 

7. Los productos con láser están provistos de indicaciones de advertencia normalizadas en función de la 
clase de láser del que se trate. Los rayos láser pueden provocar daños de tipo biológico a causa de 
las propiedades de su radiación y debido a su concentración extrema de potencia electromagnética. 
En caso de que un producto Rohde & Schwarz contenga un producto láser (p. ej. un lector de 
CD/DVD), no debe usarse ninguna otra configuración o función aparte de las descritas en la 
documentación del producto, a fin de evitar lesiones (p. ej. debidas a irradiación láser). 

8. Clases CEM (según CISPR 11) 
Clase A: dispositivo apropiado para el uso en cualquier zona excepto en áreas residenciales y en 
aquellas zonas que se encuentran conectadas a una red de suministro de baja tensión que alimenta 
un edificio de viviendas. 
Clase B: dispositivo apropiado para el uso en áreas residenciales y en aquellas zonas que se 
encuentran conectadas a una red de suministro de baja tensión que alimenta un edificio de viviendas. 

Reparación y mantenimiento 

1. El producto solamente debe ser abierto por personal especializado con autorización para ello. Antes 
de manipular el producto o abrirlo, es obligatorio desconectarlo de la tensión de alimentación, para 
evitar toda posibilidad de choque eléctrico.  
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2. El ajuste, el cambio de partes, el mantenimiento y la reparación deberán ser efectuadas solamente 
por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los 
aspectos de seguridad (p. ej. el enchufe, los transformadores o los fusibles), solamente podrán ser 
sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad 
deberá realizarse un control de seguridad (control a primera vista, control del conductor de 
protección, medición de resistencia de aislamiento, medición de la corriente de fuga, control de 
funcionamiento). Con esto queda garantizada la seguridad del producto.  

Baterías y acumuladores o celdas 

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterías y 
acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible 
consecuencia de muerte. El manejo de baterías y acumuladores con electrolitos alcalinos (p. ej. celdas de 
litio) debe seguir el estándar EN 62133. 

1. No deben desmontarse, abrirse ni triturarse las celdas.  

2. Las celdas o baterías no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz 
directa del sol. Las celdas y baterías deben mantenerse limpias y secas. Limpiar las conexiones 
sucias con un paño seco y limpio. 

3. Las celdas o baterías no deben cortocircuitarse. Es peligroso almacenar las celdas o baterías en 
estuches o cajones en cuyo interior puedan cortocircuitarse por contacto recíproco o por contacto con 
otros materiales conductores. No deben extraerse las celdas o baterías de sus embalajes originales 
hasta el momento en que vayan a utilizarse. 

4. Las celdas o baterías no deben someterse a impactos mecánicos fuertes indebidos. 

5. En caso de falta de estanqueidad de una celda, el líquido vertido no debe entrar en contacto con la 
piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un 
médico. 

6. En caso de cambio o recarga inadecuados, las celdas o baterías que contienen electrolitos alcalinos 
(p. ej. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o 
baterías solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de 
recambios).  

7. Las baterías y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterías o 
acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales. 
Respete en esta relación las normas nacionales de eliminación y reciclaje.  

Transporte 

1. El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con 
precaución y, si es necesario, usando un sistema de elevación adecuado (p. ej. una carretilla 
elevadora), a fin de evitar lesiones en la espalda u otros daños personales.  

2. Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por 
personas. Por eso no está permitido utilizar las asas para la sujeción en o sobre medios de transporte 
como p. ej. grúas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los 
productos de manera segura a los medios de transporte o elevación. Para evitar daños personales o 
daños en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o 
elevación utilizado. 
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3. Si se utiliza el producto dentro de un vehículo, recae de manera exclusiva en el conductor la 
responsabilidad de conducir el vehículo de manera segura y adecuada. El fabricante no asumirá 
ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un 
vehículo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehículo 
debidamente para evitar, en caso de un accidente, lesiones u otra clase de daños.  

Eliminación/protección del medio ambiente 

1. Los dispositivos marcados contienen una batería o un acumulador que no se debe desechar con los 
residuos domésticos sin clasificar, sino que debe ser recogido por separado. La eliminación se debe 
efectuar exclusivamente a través de un punto de recogida apropiado o del servicio de atención al 
cliente de Rohde & Schwarz. 

2. Los dispositivos eléctricos usados no se deben desechar con los residuos domésticos sin clasificar, 
sino que deben ser recogidos por separado. 
Rohde & Schwarz GmbH & Co.KG ha elaborado un concepto de eliminación de residuos y asume 
plenamente los deberes de recogida y eliminación para los fabricantes dentro de la UE. Para 
desechar el producto de manera respetuosa con el medio ambiente, diríjase a su servicio de atención 
al cliente de Rohde & Schwarz. 

3. Si se trabaja de manera mecánica y/o térmica cualquier producto o componente más allá del 
funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales 
pesados como p. ej. plomo, berilio o níquel). Por eso el producto solo debe ser desmontado por 
personal especializado con formación adecuada. Un desmontaje inadecuado puede ocasionar daños 
para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminación de 
residuos. 

4. En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que 
deban tratarse como residuos especiales (p. ej. refrigerantes o aceites de motor con intervalos de 
cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas 
sustancias y las normas regionales de eliminación de residuos. Tenga en cuenta también en caso 
necesario las indicaciones de seguridad especiales contenidas en la documentación del producto. La 
eliminación incorrecta de sustancias peligrosas o combustibles puede causar daños a la salud o 
daños al medio ambiente. 

Se puede encontrar más información sobre la protección del medio ambiente en la página web de 
Rohde & Schwarz. 
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Customer Support 
 

Technical support – where and when you need it 
For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support 
Centers. A team of highly qualified engineers provides telephone support and will work with you to find a 
solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz 
equipment. 
 

Up-to-date information and upgrades 
To keep your instrument up-to-date and to be informed about new application notes related to your 
instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish. 
We will take care that you will get the right information. 
 

Europe, Africa, Middle East Phone +49 89 4129 12345 
customersupport@rohde-schwarz.com

North America Phone 1-888-TEST-RSA (1-888-837-8772) 
customer.support@rsa.rohde-schwarz.com

Latin America Phone +1-410-910-7988 
customersupport.la@rohde-schwarz.com

Asia/Pacific Phone +65 65 13 04 88 
customersupport.asia@rohde-schwarz.com

China Phone +86-800-810-8228 /  
 +86-400-650-5896 
customersupport.china@rohde-schwarz.com

mailto:customersupport.asia@rohde-schwarz.com
mailto:customersupport.la@rohde-schwarz.com
mailto:customer.support@rsa.rohde-schwarz.com
mailto:customersupport@rohde-schwarz.com
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R&S OSP Documentation Map 
Quick Start Guide 

The present quick start guide describes everything that is needed to put the instrument 
into operation and helps you to get familiar with the unit. The quick start guide gives an 
introduction to the instrument’s functionality and provides procedures for typical 
applications.  

Documentation CD-ROM 

The CD-ROM provides the complete user documentation for the instrument: 

● The data sheet in printable form.   

● The quick start manual in printable form. 

● The operating manual in printable form. 

● The service manual in printable form. 

● Links to different useful sites in the R&S internet. 

Optional Printed Documentation 

The printed manual provides the complete user documentation, including the operating 
manual and service manual. This manual can be ordered as an option; see ordering 
information in the “Specifications”. Besides the CD-ROM contains *.pdf versions of the 
operating and service manual. 

Internet Site 

The Internet site at: Open switch and Control unit R&S OSP provides the most up to 
date information on the R&S OSP. The current operating manual at a time is available 
as printable PDF file in the download area. 

Also provided for download are firmware updates including the associated release 
notes, instrument drivers, current data sheets and application notes. 

 

http://www.rohde-schwarz.com/product/osp.html
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EC Certificate of Conformity 
 

Certificate No.: 2007-68 
 
This is to certify that: 
 

Equipment type Stock No. Designation 

OSP120 1505.3009.02 Basic Unit 
OSP150 1505.3009.05 Extender Unit 
 
OSP-B101 1505.5101.02 RF Switch Module 
OSP-B102 1505.5201.02 RF Switch Module 
OSP-B103 1505.5301.02 Module 

 
complies with the provisions of the Directive of the Council of the European Union on the 
approximation of the laws of the Member States  
 
- relating to electrical equipment for use within defined voltage limits  

(2006/95/EC) 
 
- relating to electromagnetic compatibility  

(2004/108/EC) 
 
Conformity is proven by compliance with the following standards: 
 
EN 61010-1 : 2001 
EN 61326 : 1997 + A1 : 1998 + A2 : 2001 + A3 : 2003 
EN 55011 : 1998 + A1 : 1999 + A2 : 2002, Klasse B 
EN 61000-3-2 : 2000 + A2 : 2005 
EN 61000-3-3 : 1995 + A1 : 2001 
 
For the assessment of electromagnetic compatibility, the limits of radio interference for Class 
B equipment as well as the immunity to interference for operation in industry have been used 
as a basis. 
 
Affixing the EC conformity mark as from 2007 
 

ROHDE & SCHWARZ GmbH & Co. KG 
Mühldorfstr. 15,  D-81671 München 

 
Munich, 2007-12-19 Central Quality Management MF-QZ / Radde 
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1 Preparing for Use 
The following topics will help you to get familiar with the instrument and perform the 
first steps: 

● Front Panel Tour R&S OSP120 or Front Panel Tour R&S OSP130 or Front Panel 
Tour R&S OSP150 

● Rear Panel Tour 
● Putting the Instrument into Operation 

General Safety Instructions 

Please make sure to observe the instructions of the following sections so that you 
cannot cause damage to the instrument or endanger people. This is of particular 
importance when you use the instrument for the first time. Also observe the general 
safety instructions at the beginning of this manual. 

1.1 Front Panel Tour R&S OSP120 

This chapter gives an overview of the front panel controls and connectors of the 
R&S OSP120 and gives all information that is necessary to put the instrument into 
operation and connect external devices. Notes on reinstallation of the instrument 
software appear at the end of the chapter.  

Chapter 2.3, OSP Panel Functions, of this manual provides an introduction to the 
operation of the instrument by means of the control program OSP Panel. For a 
description of the operating concept and an overview of the instrument’s capabilities 
refer to the Instrument Functions (chapter 4).  

The front panel of the R&S OSP120 consists of STANDBY switch, Status LEDs and 
connectors. Brief explanations on the function of these items and the rear panel can be 
found on the next pages.  
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1.1.1 Status LEDs and Standby Key 

The status LEDs and the standby toggle switch are located in the bottom right corner of 
the front panel. See also chapter 1.5.9.

The status LEDs light to indicate the following instrument states:  

PWR: shows standby (yellow LED) and ready state (green LED).  

LAN: shows if data are received via LAN network; seel Remote Control (chapter 5 in the 
Operating Manual).  

CLK: is flashing if data are transferred via CAN bus.  
On an R&S OSP150, the logic is inverted: the CLK indicator goes off shortly during 
CAN bus activity. 

The STANDBY key serves the following purpose:  

Toggle between standby and ready state (indicated by the yellow and green PWR 
LED, respectively). 

1.1.2 Front Panel Connectors 

1.1.2.1 USB Connectors 

Single Universal Serial Bus connectors of type A (master USB), used to connect a 
keyboard or flash drive. All front panel USB connectors comply with standard USB 2.0; 
refer to the "Specifications". 

 

USB Connection 

The length of passive connecting USB cables should not exceed 1 m. The maximum 
current per USB port is 500 mA. It is recommended to use double-shielded USB 
cables. 
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1.1.2.2 Monitor Connector 

An external monitor with a digital interface can be connected to the MONITOR 
DIGITAL connector on the front panel of the R&S OSP120. An external monitor, 
together with a keyboard, is a prerequisite for manual intervention in order to define 
the LAN configuration or in case of service to have access to the Linux Operating 
system. 

 

Monitor connection: 

Before the external monitor is connected, the instrument must be switched off (standby 
mode) to prevent damage to the monitor and the R&S OSP120. After connection, the 
external monitor is detected when the instrument is started. The Linux Operating 
system menu of the R&S OSP is then displayed on the external monitor. Further 
settings are not required. 

It is recommended to use a double-shielded monitor cable equipped with ferrites at 
each end. 

1.2 Front Panel Tour R&S OSP130 

This chapter gives an overview of the front panel controls and connectors of the 
R&S OSP130 and gives all information that is necessary to put the instrument into 
operation and connect external devices. Notes on reinstallation of the instrument 
software appear at the end of the chapter.  

The chapter Getting Started of this manual provides an introduction to the operation of 
the instrument by means of the control program OSP Panel. For a description of the 
operating concept and an overview of the instrument’s capabilities refer to the 
Instrument Functions (chapter 4). The graphical user interface on the instrument is 
explained in chapter 4.3.

The front panel of the R&S OSP130 has the same STANDBY key and Status LEDs as 
the R&S OSP120. See the corresponding sections in chapter 1.1.1 for details. There is 
no connector for an external monitor. 
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1.2.1 Navigation Keys 

The navigation keys allow access to the various functions of the graphical user 
interface. They can be subdivided into three groups. 

 In the top row next to the screen there are three keys to quickly access different 
hierarchy levels in the menus.  

pressing the key  MENU  activates the top level menu.  

pressing the key  BACK  moves up in hierarchy by one menu level.  

pressing the key  HOME  leaves the menu and displays the Main menu screen 

In the top row next to the screen there are three keys to quickly access different 
hierarchy levels in the menus.  

 With the cursor keys the focus is moved within the screen elements; see a detailed 
description in chapter 4.3. 

In the top row next to the screen there are three keys to quickly access different 
hierarchy levels in the menus.  

pressing the key  FUNCTION  executes a switching action, if applicable.  

pressing the key  OK  confirms a selection, for example for going to the next menu level.  

pressing the key  STATUS  displays status information for the chosen item (device or 
module) or changes the selection of a switch for path configuration. 

1.2.2 Status Keys 

The status keys serve the following purposes: 

The  OFF  key is not used at the moment. 

The  ON  key is not used at the moment.  

Pressing the  RESET  key leaves the menu and displays the Main menu screen. 

The  LOCAL  key is not used at the moment. 
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1.2.3 Status Indicators 

The status indicators have the following meaning: 

Error in supply voltage, please contact service. 

General error condition. Please note any additional information what could have led to 
this condition and contact R&S if the error is reproducible. 

General warning condition. Not used at the moment. 

Indicates communication via the CAN interface. 

Indicates communication via the CAN interface as well. 

1.2.4 Front Panel USB Connectors 

Single Universal Serial Bus connectors of type A (master USB), used to connect a 
keyboard or flash drive. All front panel USB connectors comply with standard USB 2.0; 
refer to the "Specifications". 

 

USB Connection 

The length of passive connecting USB cables should not exceed 1 m. The maximum 
current per USB port is 500 mA. It is recommended to use double-shielded USB 
cables. 

1.3 Front Panel Tour R&S OSP150 

This chapter gives an overview of the front panel controls of the R&S OSP150. The 
front panel of the R&S OSP150 is similar to the front panel of the R&S OSP120 having 
the Standby key and the three status LEDs but does not have any connector. See 
chapter 1.1.1 for the description of the front panel elements. 

Please notice that the operation of the CLK LED is different to OSP120 and OSP130. 
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1.4 Rear Panel Tour  

This section gives an overview of the rear panel connectors of the R&S OSP120. The 
rear panels of the R&S OSP130 and of the R&S OSP150 are almost identical to it. 

The rear connectors and interfaces are described in detail in the complete operating 
manual. The following connectors are available on the instruments: 

● LAN connector (RJ-45) is used to integrate the instrument to a Local Area Network, 
primarily for remote control purposes. This connector is not available on the 
R&S OSP150. 

● CAN bus connector (D-Sub, 9 pin) is a control port to connect one or several 
extension units R&S OSP150. 

The R&S OSP owns three slots which can be configured with the options available for 
the R&S OSP. The above configuration shows the following options: 

● Option R&S OSP-B101: Relay module consisting of six coaxial relays of SPDT 
type; the RF coaxial connectors are SMA type 

● Option R&S OSP-B102: Relay module consisting of two coaxial relays of SP6T 
type; the RF coaxial connectors are SMA type 

● Option R&S OSP-B103: I/O module with 16 Bit input / output ports; the connectors 
are D-Sub types, 25 pin, female for output and male for input 

In case of the options which can be installed in the R&S OSP, the connectors related to 
each option are described in detail in chapter R&S OSP Module Interfaces. 

1.4.1 LAN Connector  

8-pin LAN connector RJ-45 used to connect the R&S OSP120 or OSP130 to a Local 
Area Network (LAN). Refer to Remote Operation in a LAN. 

LAN Connection 

Depending on the connection (a non-dedicated network connection or dedicated 
connection to a single controller) a standard RJ-45 cable or cross-over RJ-45 cable is 
required. See chapter 1.9.1 for further information. 

It is recommended to use double-shielded LAN cables. 
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1.4.2 CAN Bus Connector 

9-pin connector D-Sub male used to connect the R&S OSP120 or OSP130 to 
extension units OSP150. Refer to Instrument Functions in chapter 4.

Maximum input levels 

The maximum input levels and voltages of the input connectors at the front and rear 
panel must not be exceeded. 

Supply Voltage over CAN bus 

In some CAN bus applications the R&S OSP120, OSP130 or OSP150 is required to 
deliver the supply voltage to an external device. An example for this is the connection 
of the fiber-optic extender R&S OSP-Z104. Using the cable OSP-Z106 is 
recommended for this case. 

However, when connecting an R&S OSP150 to an OSP120 or OSP130, this supply 
voltage line must not be present. Using the connecting cables R&S OSP-Z101 or 
R&S OSP-Z102 is recommended. Not observing these precautions may damage the 
power supplies in the R&S OSP. 

See also chapter 8 in the operating manual for the pinout of the CAN bus connector. 

1.4.3 Mains Switch and Connector 

The mains connector is located at the bottom left corner of the rear panel. 

Next to the connector is a mains fuse, and above the fuse the mains switch. With the 
positions “0” the instrument is disconnected from mains, and in position “1” it is 
connected. See chapters 1.5.6 and 1.5.7 for more information. 
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1.5 Putting the Instrument into Operation  

This section describes the basic steps to be taken when setting up the R&S OSP for 
the first time.  

Instrument setup 

Before turning on the instrument, please make sure that the following conditions are 
fulfilled: 

● Instrument covers are in place and all fasteners are tightened.  

● Fan openings are unobstructed.  

● Signal levels at the input connectors are all within the specified ranges.  

● Signal outputs are correctly connected and not overloaded.  

● The instrument is dry and shows no condensation. 

Non-observance may cause damage to the instrument or other devices in the test setup. 

1.5.1 Unpacking the Instrument and Checking the Shipment 

1. Remove the instrument from its packaging and check the equipment for 
completeness using the delivery note and the accessory lists for the various items. 

2. First, pull off the polyethylene protection pads from the instrument's rear feet and 
then carefully remove the pads from the instrument handles at the front. 

3. Pull off the corrugated cardboard cover that protects the rear of the instrument. 

4. Carefully unthread the corrugated cardboard cover at the front that protects the 
instrument handles and remove it. 

5. Check the instrument for any damage. If there is damage, immediately contact the 
carrier who delivered the instrument. In this case, make sure not to discard the box 
and packing material. 
It is advisable to keep the original packing material in order to prevent control 
elements and connectors from being damaged in case the instrument is to be 
transported or shipped at a later date. 
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1.5.2 Instrument Setup  

The R&S OSP is designed for use under laboratory conditions, either on a bench top 
or in a rack. The general ambient conditions required at the operating site are as 
follows:  

● The ambient temperature must be in the ranges specified for operation and for 
compliance with specifications (see "Specifications"). 

● All fan openings including the rear panel perforations must be unobstructed. The 
distance to the wall should be at least 10 cm.  

1.5.3 Bench Top Operation 

If the R&S OSP is operated on a bench top, the surface should be flat.  

The instrument is used in horizontal position, standing on its feet.  

1.5.4 Mounting in a 19" Rack 

The instrument can be mounted in 19" racks using a ZZA-211 adapter (order number 
1096.3260.00). Please note the mounting instructions supplied with the rack adapter.  

Optional notice heading 

Allow for sufficient air supply in the rack. 

Make sure that there is sufficient space between the ventilation holes and the rack 
casing. 

1.5.5 EMI Protective Measures  

In order to avoid electromagnetic interference (EMI), the instrument may only be 
operated when it is closed and with all shielding covers fitted. Only appropriate 
shielded signal and control cables may be used.  
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1.5.6 Connecting the Instrument to the AC Supply 

The R&S OSP is automatically adapted to the AC supply voltage supplied. The supply 
voltage must be between 100 V and 240 V with frequencies ranging from 50 Hz to 
60 Hz (see also the tolerances quoted in the "Specifications"). The mains connector is 
located in the lower left corner of the rear panel.  

● Connect the instrument to the AC power source using the AC power cable 
delivered with the instrument.  

The maximum power consumption of the instrument depends on the installed options. 
The typical power consumption is also listed in the "Specifications".  

The R&S OSP is protected by two fuses located in the fuse holder below the AC power 
switch; see Replacing Fuses. 

1.5.7 Power on and off 

The mains connector is located at the bottom left corner of the rear panel.  

To turn the power on or off, press the AC power switch to position I (On) or 0 (Off). 

See also Replacing Fuses.

After power-on, the R&S OSP instrument is in ready state after about 30 seconds.  

The STANDBY key at the front panel of the instrument is used to toggle between 
standby and ready state. The AC power switch can be permanently on.  

Switching off is required only if the instrument must be completely removed from the 
AC power supply but may be used in order to reduce power consumption when not in 
use.  

Extension units 

If communication between OSP120 or OSP130 and any extension unit OSP150 
connected via CAN bus cannot be established properly, try to turn on the extension 
unit(s) first before turning on the OSP120 or OSP130. 
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1.5.8 Replacing Fuses 

The instrument is protected by two fuses (IEC 127- T4.0H/250V, stock no. 
0020.7600.00) located in the fuse holder below the AC power switch on the rear panel.  

Shock hazard 

For fuse replacement, ensure that the instrument is switched off and disconnected 
from the power supply by removing the plug from the AC power connector. 

To replace the fuses  

1. Open the lid of the AC power connector.  

2. Lift the fuse holder out of its slot.  

3. Exchange the fuses.  

4. Put the fuse holder back in its slot and close the lid.  

1.5.9 Standby and Ready State 

The STANDBY toggle switch is located in the bottom right corner of the front panel.  

After switching on the AC power, the R&S OSP is in ready mode after about 
30 seconds. 

Press the STANDBY key on the front panel briefly to switch the R&S OSP from the 
standby to ready state or vice versa. 

In standby state, the left PWR LED is yellow. The standby power only supplies the 
power switch circuits. In this state it is safe to switch off the AC power and disconnect 
the instrument from the power supply. 

After Power On or when changing from Standby to Ready state, the left PWR LED is 
immediately switched to green and all modules are power-supplied. Please note that 
the Linux operating system of R&S OSP takes about 30 seconds to start up. After this 
time the R&S OSP is ready for operation. 

Shock hazard 

The instrument is still power-supplied while it is in standby mode. 
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1.6 Maintenance  

The R&S OSP does not require any special maintenance. Make sure that the air vents 
are not obstructed. The outside of the instrument is suitably cleaned using a soft, non-
fluffy dust cloth. 

Instrument damage caused by cleaning agents 

Cleaning agents contain substances that may damage the instrument, e.g. solvent-
containing cleaning agents may damage the front panel labeling or plastic parts. Never 
use cleaning agents such as solvents (thinners, acetone, etc), acids, bases, or other 
substances.  

For our support center address and a list of useful R&S contact addresses refer to the 
pages at the beginning of this manual.  

1.6.1 Storing and Packing 

The R&S OSP can be stored at the temperature range quoted in the data sheet. When 
it is stored for a longer period of time the instrument should be protected against dust.  

The original packing should be used, particularly the protective caps at the front and 
rear, when the instrument is to be transported or dispatched. If the original packing is 
no longer available, use a sturdy cardboard box of suitable size and carefully wrap the 
instrument to protect it against mechanical damage.  

1.7 Connecting External Accessories 

The LAN interface at the rear panel of the R&S OSP120 or OSP130 is used for remote 
control of the instrument: 

● A LAN connection can be established in order to remotely control the instrument 
from an external PC (see Connecting a LAN Cable).  

In addition the R&S OSP120 provides interfaces for monitor connection and USB 
connection:  

● An external monitor shows the menus of the Linux Operating System, if any 
access or setup within the Linux Operating System should be necessary.  

● A keyboard simplifies the entry of data (see Connecting a Keyboard). 
● A flash drive supports the firmware update (see Connecting a USB Flash Drive). 
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1.7.1 Connecting a USB Flash Drive 

A USB flash drive can be connected to one of the USB Connectors on the front panel 
of the R&S OSP120 or OSP130. 

The flash drive is detected automatically when it is connected.  

1.7.2 Connecting a Keyboard 

A keyboard can be connected to one of the USB Connectors on the front panel of the 
R&S OSP120.  

The keyboard is detected automatically when it is connected. The default input language is 
English – US. Refer to chapter 1.10.1 for changing the keyboard properties. 

Keyboard configuration 

The keyboard configuration already is pre-configured. 
Operating the R&S OSP120 does not require a keyboard. Usually all essential 
functions can be controlled via LAN interface. 

1.7.3 Connecting a Monitor 

A standard monitor can be connected to the DVI-D connector on the front panel of the 
R&S OSP120.  

Monitor configuration 

There is no particular configuration of the monitor required. 
Operating the R&S OSP120 does not require a monitor. Usually all essential functions 
can be control via LAN interface. 

Monitor connection 

The monitor must be connected while the instrument is switched off (in standby mode). 
Otherwise correct operation can not be guaranteed. 

The monitor displays the menus of the Linux Operating System which is integral part of 
the R&S OSP120. The monitor together with keyboard is required if any setups / 
changes have to be done in the Linux operating system. 
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1.7.4 Connecting a LAN Cable 

A LAN cable can be connected to the LAN connector on the rear panel of the 
R&S OSP120 or OSP130. To establish a LAN connection proceed as follows:  

Refer to chapter Assigning an IP Address and learn how to avoid connection errors. 

Connect an appropriate LAN cable to the LAN port. Use a commercial RJ-45 cable to 
establish a non-dedicated network connection, or a cross-over RJ-45 cable to 
establish a dedicated connection between the instrument and a single PC.  

Dedicated vs. non-dedicated network connections 

There are two methods to establish a LAN connection of the R&S OSP:  

● A non-dedicated network (Ethernet) connection from the instrument to an existing 
network made with an ordinary RJ-45 network cable. The instrument is assigned an IP 
address and can coexist with a computer and with other hosts on the same network.  

● A dedicated network connection between the instrument and a single computer made 
with a cross-over RJ-45 network cable. The computer must be equipped with a network 
adapter and is directly connected to the instrument. The use of hubs, switches, or 
gateways is not needed, however, data transfer is still made using the TCP/IP protocol.  

1.8 Starting the R&S OSP and Shutting Down 

To start the R&S OSP, proceed as follows: 

● Make sure that the instrument is connected to the AC power supply and switch the 
power switch (see chapter 1.5.7) on the rear panel to position I (On). All modules of 
the R&S OSP are powered (the left PWR LED is green) and after about 30 
seconds the instrument is in ready state. 

● If necessary, press the STANDBY toggle switch (see chapter 1.5.9) on the front 
panel to switch the instrument to ready state (the left PWR LED is green).  

● In ready state, the instrument already has booted the Linux Operating System (see 
chapter 1.10) and started the R&S OSP application. Independent of the last setup, the 
R&S OSP always starts with the default conditions, i.e. all relays in reset condition. 

To shut down the R&S OSP, proceed as follows: 

● Press the STANDBY key, which will shut down the Linux operating system and set the 
instrument to standby state.  

● If desired, set the AC power switch to position 0 (Off).  

Standby state 

It is recommended to switch the R&S OSP to standby state before disconnecting it 
from the AC supply. 
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1.9 Remote Operation in a LAN  

A LAN connection is used to integrate the R&S OSP (not the OSP150) into a 
home/company network. The LAN connection is required for:  

● Remote control operation of the R&S OSP120 or OSP130. 
● Manual control of the R&S OSP from a remote computer using the "OSP Panel" 

application.  

To establish the connection proceed as follows: 

● Assign an IP address to the R&S OSP following the directions below and connect 
the instrument to the network as described in chapter Connecting a LAN Cable. 

1.9.1 Assigning an IP Address 

Depending on the network capacities, the IP address information for the R&S OSP120 or 
OSP130 can be obtained in different ways.  

● If the network supports dynamic TCP/IP configuration using the Dynamic Host 
Configuration Protocol (DHCP), all address information can be assigned 
automatically.  

● If the network does not support DHCP, or if the instrument is set to use alternate 
TCP/IP configuration, a static IP address is used.  

By default, the R&S OSP is configured either to use: 

● A dynamic TCP/IP configuration and obtain all address information automatically. 
This means that it is safe to establish a physical connection to the LAN without any 
previous R&S OSP configuration. 
(Priority 1) 

● A user defined static IP address. This address can be defined (but must not) in 
addition to the default address. See chapter 2.3.3 for information how to configure 
the user defined IP address via the OSP Panel application.
(Priority 2) 

● A static default IP address. Per default, the R&S OSP is set to the IP address 
192.168.48.147. See also chapter 2.1.
(Priority 3) 

Please note the priorities shown above which is related to IP address handling done by 
the OSP. 

Valid IP addresses 

If your network does not support DHCP, or if you choose to disable dynamic TCP/IP 
configuration, you must assign valid address information before connecting the 
R&S OSP to the LAN. Contact your network administrator to obtain a valid IP address, 
because connection errors can affect the entire network. 
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Reading the IP address 

When using the dynamic TCP/IP configuration, the actual IP address information will 
be displayed when booting the R&S OSP. Proceed as follows: 

● Connect the R&S OSP via a commercial RJ-45 cable to your network supporting 
DHCP 

● Switch on the R&S OSP120 with Monitor and Keyboard connected (not applicable 
to the OSP130) 

● At the end of the booting process, the IP address will be displayed as shown below 
for the OSP120 and the OSP130. The values of the IP address shown are only 
examples. 

 

► Press Okay button or the ENTER key on the keyboard (OK key for the 
R&S OSP130) for confirmation and to continue the operation. 

Manual TCP/IP configuration 

If your network does not support DHCP, proceed as follows: 

1. Connect the R&S OSP120 or OSP130 via a cross-over RJ-45 cable to your 
computer (or network not supporting DHCP). 

2. Set the network configuration of your computer to work with a static IP address. 
The following setup is recommended: 

3. Switch on the R&S OSP and wait until boot-up is finished. 

The R&S OSP now can be accessed under its default IP address from your computer. 
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1.9.2 OSP Panel 

The R&S OSP120 has no elements for front panel operating. A “manual” operation is 
achieved via the R&S application OSP Panel. 

"OSP Panel" is a Windows application which can be used to access and control the 
R&S OSP120 or the OSP130 from a remote computer through a LAN connection. The 
OSP Panel allows full access to all R&S OSP functions.  

To start the OSP Panel connection  

1. Connect the R&S OSP to a LAN and determine its IP address; see Remote 
Operation in a LAN. It is necessary to have a VISA library installed on your 
computer. 

2. Install the OSP Panel application on your computer (connected to the LAN). The 
installation setup includes the VISA libraries which are necessary for running the 
OSP Panel. 

3. Start the OSP Panel, specify the correct IP address in the OSP Panel, and the 
R&S OSP can be manually controlled.  

For detailed information about OSP Panel refer to the chapter 2.3 OSP Panel 
Functions. 



R&S® OSP Preparing for Use 
Linux Operating System 

Quick Start Guide 1505.3896.12-09 23 

1.10 Linux Operating System 

The R&S OSP is equipped with a Linux operating system which has been configured 
according to the instrument's features and needs. Changes in the system configuration 
can be necessary in order to  

● Establish a LAN connection.
● Customize the properties of the keyboard connected to the R&S OSP120.  
● Call up additional software tools. 

Configuration of the operating system, updates 

The operating system is adapted to the R&S OSP. To avoid impairment of instrument 
functions, only change the settings described in this manual. Existing software must be 
modified only with update software released by Rohde & Schwarz. Likewise, only programs 
authorized by Rohde & Schwarz for use on the instrument must be executed. 

1.10.1 Keyboard Properties 

The keyboard properties can be changed via the console of the Linux Operating 
System. To customize the keyboard properties, perform the following steps:  

1. Switch off the R&S OSP. 

4. R&S OSP120: Connect the external monitor and keyboard to the R&S OSP120 
and switch on the instrument. The messages of the Linux boot process are displayed 
on the monitor. Wait until the boot process is finished (takes about 30 seconds) and 
press the <ENTER> key. 

5. R&S OSP130: Connect the external keyboard to the R&S OSP120 and switch on 
the instrument. Wait until booting is complete. Change from regular display to 
Linux system login by pressing the keys CTRL + ALT + F3. 

6. When asked for the login, use the login name root and the password root.

To change the keyboard properties to German, type <de> and conform with the 
<ENTER> key. The keyboard properties will be kept until the instrument is switched off. 
After booting of the instrument, the default keyboard configuration (English US) is set 
up again. 
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1.11 Firmware Update 

This chapter contains information on firmware update and Linux operating system 
update to the R&S OSP120 or OSP130. 

Possible impairment of the functioning of the instrument 

The instrument is equipped with the Linux operating system. It is thus possible to install COTS 
software in the instrument. The use and installation of commercial off-the-shelf (COTS) 
software may impair the instrument function. For this reason, we recommend that you only 
execute programs tested by Rohde & Schwarz with regard to their compatibility with the 
instrument software. In certain cases, the use of these programs can impair the performance 
of the instrument. 

The drivers and programs used in the instrument under Linux have been adapted to 
the test instrument. Existing instrument software must only be modified with update 
software released by Rohde & Schwarz. 

The firmware update packages for the R&S OSP120 and OSP130 are integrated in a 
single setup file "OSP<xxx>.rsu" (<xxx> denotes the version of the firmware update). 
Firmware updates as well as the Release Notes describing the improvements and 
modifications are provided on the Internet at the download site of the R&S OSP 
homepage.  

The installation of a new firmware version is performed via the USB interface. A de-
installation of the old firmware is not necessary. The firmware update is performed 
while the instrument is running. The new firmware will be loaded right after the update 
process. 

To perform a firmware update, perform the following steps. 

1. The update file has to be downloaded from the Internet to a PC. From there the file 
should be transferred to a USB flash drive which will later be plugged into the USB 
interface of the R&S OSP. 

2. Connect the external monitor and keyboard to the R&S OSP120 and switch on the 
instrument. Wait until booting is complete. 

3. Connect the USB flash drive to one of the two USB interfaces on the R&S OSP 
front panel. If the instrument recognizes a flash drive at its USB interface, and finds 
valid update versions, the Software Update Process is started. Press the Yes 
button (OK key on OSP130) to continue 

All update versions (files with extension .rsu) stored on the flash drive now are offered 



R&S® OSP Preparing for Use 
Read the actual the Firmware Version 

Quick Start Guide 1505.3896.12-09 25 

for selection. Thus, an upgrade or downgrade of the firmware is possible at any time. 
Select the required firmware update version and press the OK button. 

It is recommended not to switch off the instrument or to remove the USB flash drive 
while the firmware update is running. 

If the software update is complete, the USB flash drive has to be removed. A message 
box is coming up to confirm the removal of the flash drive . After confirmation the 
instrument starts rebooting. 

The R&S OSP is now ready to operate with the new firmware version. 

Before using the R&S OSP, repeat the registration process. See chapter2.3.2 for details. 

Firmware Update: 

The firmware update is not allowed to be performed running the GUI via Web-Browser 
and VNC. Doing this will abort the firmware installation procedure!  

1.12 Read the actual the Firmware Version 

The currently installed firmware version of the different R&S OSP units can be read in 
several ways as described in the following chapters. 

1.12.1 Get Firmware Version using OSP Panel 

The firmware versions of all OSP models can be read using the application OSP Panel. 
Start the OSP Panel and select the function >File >System Info. 

This function displays the OSP System information together with the actual Firmware 
version. The Firmware version is shown in the OSP Identification string as highlighted 
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in the following example (Version 1.5).  

1.12.2 Get Firmware Version via SCPI command 

In remote mode the current OSP Firmware Version can be read via the “*IDN?” 
command. When sending the Identification command, the OSP prompts back the 
following answer (example for OSP120) after pressing the Read button (see below 
example). 

The last part of the string shows the actual firmware version (1.5 for the above 
example). 
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2 Getting Started 
This chapter helps you to get familiar with the R&S OSP and explains how to solve 
basic tasks that you will frequently encounter when working with the instrument. Since 
the R&S OSP120 only has remote control capability, the manual operation of the 
instrument is achieved via the application OSP Panel which runs on an external 
computer connected to the same LAN network as the R&S OSP120. The OSP Panel, 
however, can also be used with the R&S OSP130. 

The following chapter gives a short overview on the operation of the OSP Panel as 

● Installing OSP Panel 
● OSP Panel Functions 
● Sample Session 

Risk of shock hazard and instrument damage 

Before starting any measurement on your R&S OSP, please note the instructions 
given in chapter Preparing for Use. 

In the chapter Manual Operation you will find information on customizing the 
instrument according to your personal preferences. Chapter 3 also provides 
information on typical applications of the R&S OSP platform. 

In the following we assume that you are familiar with standard Windows dialogs and 
mouse operation.  

2.1 Connecting R&S OSP and PC 

Please read chapter 1.9.1 for understanding the possibilities of IP address 
assignments. The following setup describes the connection of the R&S OSP120 or 
R&S OSP130 within a dedicated network; i.e. the connection to a single computer, in 
case you are not using the dynamic TCP/IP configuration (DHCP). 

When using the dynamic TCP/IP configuration (DHCP), these steps are not required. 

To set up a LAN connection, proceed as follows: 

● Connect the R&S OSP to the computer using a cross-over RJ-45 cable: 
Ensure that the network configuration of the computer is set to the required 
protocol. Select >Settings >Control Panel >Network Connections. Select the 
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properties of the active interface, then the properties of the TCP/IP protocol, and 
set the following IP address: 

● The R&S OSP is configured by default to IP address 192.168.48.147.
This address is to be entered in the OSP Panel application when using the 
examples described in the following chapters. 

When a static IP address other then the default address is required, it can be changed 
using the OSP Panel. See chapter 2.3.3 for detailed information. 

2.2 Installing OSP Panel 

The OSP Panel installation setup is available on CD which is part of the R&S OSP 
delivery. 

The installation setup includes the VISA libraries which are necessary for running the 
OSP Panel. 

To install the application, proceed as follows:  

● Insert the documentation CD on the disk drive of your computer. 
● Select the directory “OSP Panel” on the CD, select the file setup.exe and press the 

<ENTER> button to start the installation. 
● If the installation is complete, confirm and exit the installation program. 
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2.3 OSP Panel Functions 

The following sections can help you to make efficient use of the OSP Panel, which is 
the application for manual control of the R&S OSP120 and may also be used in 
connection with the R&S OSP130. The OSP Panel offers the following features:  

● Configuration of the IP address 
● Dialogs to control the different options configured in the R&S OSP 
● Definition of path configurations 
● Direct access to SCPI commands 

The following examples are based on the assumption that the IP address has been 
obtained dynamically to be 10.33.10.173.

2.3.1 Configuring/Connecting OSP Panel 

When starting the OSP Panel, no instrument is connected via LAN network. The OSP 
Panel is in simulation mode and the following dialog appears: 

The R&S OSP remains in simulation mode as long as no connection to an instrument 
via LAN is performed. 

To connect an R&S OSP via LAN, perform the following steps: 

 1. Get the actual IP address as described in chapter 2.1 and enter the address in the 
input field RESOURCE DESCR.  

2. Press the "Connect to device" button at the upper right corner of the OSP Panel 
dialog to connect the instrument.  
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If your computer is equipped with a firewall function, it may be necessary to allow the 
firewall to unlock the OSP Panel. Here is an example of such a firewall message: 

It is recommended to allow free access to Internet for the OSP Panel. 

If the LAN connection is established, the R&S OSP device found on the LAN network is 
displayed in the left field together with the installed options.  

Note that it is necessary to register the R&S OSP once, if the instrument is switched on for 
the first time or if the configuration has changed or if a firmware update has been made. 
See chapter 2.3.3 for further information. See also chapter See also chapter "OSP Dirivers" 
in the operating manual for actions related to extensions with an OSP150. 

In the below example, an R&S OSP130 Device is found on the network which is 
equipped with three modules R&S OSP-B101, R&S OSP-B104 and R&S OSP-B102. 
Furthermore, to this device an R&S OSP150 is connected which is equipped with three 
modules R&S OSP-B101, R&S OSP-B102 and R&S OSP-B103. 
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2.3.2 Addressing R&S OSP Device 

Select the R&S OSP device in the left field of the OSP Panel dialog. 

In the lower right field of the OSP Panel dialog additional information on the R&S OSP 
is displayed as follows:  

OSP Name Shows the model of the OSP; i.e. OSP130  

OSP address The device address is read back from the OSP flash 
memory. The first OSP device (the device which can be 
addressed via LAN interface) in a system is preferably 
defined as Device F01. 

The R&S OSP address is composed out of the R&S OSP 
version (last digit of the R&S OSP Ident Number) and the 
R&S OSP serial number (6 digit number): 

Version: xxxx.xxxxK03

Serial Number: 100001 

The above example results in R&S OSP address �
3100001 

OSP Description Base unit (OSP120, OSP130) or Extension unit (OSP150)

Mainboard Serial Number: The serial number read back from the R&S OSP 
Mainboard is displayed. 

Mainboard Part Number The part number read back from the R&S OSP Mainboard 
is displayed. 

Mainboard Hardware Code The hardware code read back from the R&S OSP 
Mainboard is displayed. 

Mainboard Product Index The product index read back from the R&S OSP 
Mainboard is displayed. 

 

OSP device 

Note that no functions can be set selecting the R&S OSP Device. For the R&S OSP 
Device only the additional information as listed above can be read. 

OSP address 

If an R&S OSP is set up for the first time, it is necessary to register the R&S OSP 
address once. Otherwise it may happen that the R&S OSP is correctly detected but no 
modules are indicated. 
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To register the R&S OSP proceed as follows: 

1. Connect the instrument via LAN with the computer, where the OSP Panel is 
running (see chapter 2.3.1)

2. Start the OSP Panel, set the correct IP address, and select Connect to device. 

3. Select >Configure >System in the OSP Panel. 

The following dialog allows to register the R&S OSP: 

The OSP device which is connected to the LAN network is recommended to be defined 
as device F01 indicating the first OSP device connected with this IP address. Up to 9 
instruments can be connected to the same IP address. They are distinguished by 
different frame numbers from F01 to F09. 

1. Use the drop-down list to set the device number to F01. 

3. Type in the device address  

The OSP address is composed out of the OSP version (last digit of the OSP part 
number) and the OSP serial number (6 digit number): The information of the OSP 
version and the serial number can be found on the serial number label above the 
mains switch on the OSP’s rear side: 

Use the drop-down list to set the device number to F01. 

Version (OSP120): xxxx.xxxxK02

Serial Number: 100001 

The above example results in OSP address � 2100001 

 

4. Pressing the Add Frame button sends a corresponding command to the R&S OSP
and the information is stored on the OSP flash memory.  

The next time the OSP Panel is started and connected to the R&S OSP, the correct 
device information is read back from the OSP flash memory and all available R&S OSP 
modules are listed correctly. 

Configuration changes 

Whenever the configuration has changed by adding or removing OSP150 extension 
units, you must repeat registration. For this purpose, remove all frames except the first 
one (F01), and insert them if required as new ones. 

See also chapter"OSP Dirivers" in the operating manual for extensions with an OSP150. 
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2.3.3 Changing the IP address with OSP Panel 

The OSP Panel supports the setting of the user defineable static IP address. Please 
note that this function is supported in OSP Panel version 2.00 onwards. 
Select the menu function >Configure >TCPIP and the following dialog is opened: 

The upper half of the dialog shows the last used DHCP address and the actual static  
IP address.  
A new user defined static IP address can be entered together with a subnet mask. 

Changing of IP address 

Whenever the IP address is changed via the OSP Panel and the previous one was 
used for OSP Panel communication, you must disconnect the OSP Panel, change the 
address in the OSP Panel menu and connect to the device again. 

The OSP Panel outputs a corresponding message to the operator when changing the 
static IP address. 

2.3.4 General Actions of OSP Panel 

There are several general actions which can be done from the OSP Panel. 

With the menu function >Configure >Reset all switches in the connected R&S OSP 
are set to their default positions. 

The functions >Configure >Select all Switches and >Configure >Deselect all 
Switches define the starting point when collecting the settings for a path configuration. 
See chapter 2.4 for more details. 

The menu function >Utility > Re-Initialize Frames and Modules will re-establish the 
communication link between the R&S OSP and its modules as well as to all extension 
units OSP150. Switch settings are not changed. 

Other actions are described in the various parts of chapters 2.3 to 2.5.
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2.3.5 Addressing R&S OSP Modules 

If the OSP Device is correctly registered (see previous chapter), all R&S OSP modules 
available are displayed in the OSP Panel dialog. To control the R&S OSP modules, the 
following ways are possible: 

1. Select the required module displayed in the left field of the OSP Panel dialog. 
or 

2. Select the diagram of the required module in the upper right field of the OSP Panel 
dialog. 

By double-clicking the required R&S OSP module, a window is opened which shows all 
the setup functions available for the selected module. The title line of that window also 
indicates the slot where this module is placed, or both slots if the module has double 
width (see also chapter 4.1.2). See the following chapters for the dialogs of the 
different R&S OSP modules. 

R&S OSP module configuration 

If modules are configured in the R&S OSP but no modules are detected by the OSP 
Panel (indicated in blue), please check that the R&S OSP Device is registered 
correctly. Refer to chapter 2.3.2 to register the R&S OSP Device. 
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2.3.6 Controlling the R&S OSP-B101/-B106/-B107/-B111/-B127/-B132 

The module R&S OSP-B101 contains six RF switches of SPDT type. 
After selection of the R&S OSP-B101 module the following dialog is opened. 
The module R&S OSP-B101 contains six RF switches of SPDT type, which is shown in 
the OSP-B101 dialog. 

Clicking to the symbol of the relay, the position of each relay can be toggled individually.  

SPDT switch 

Note that the terminal NC assigns the Normally Closed position. When the relay is not 
activated, terminal NC is connected to terminal C. 
The terminal NO is the Normally Open position. If the relay is activated, the terminal 
NO is connected to terminal C. 

The buttons K11 up to K16 are not required for manual operation of the switches, but 
for defining a path configuration. 

K12 Any button K11 up to K16 in grey color indicates that this relay is not selected. A non 
selected relay is not considered when defining a path configuration.  

K11 To take over particular relays into the path configuration, the relay buttons must be 
selected by clicking on each of the relay buttons required. The selected relay is 
displayed with a button in green color. All relays whose relay buttons are selected are 
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taken over into a path configuration. 

Pressing the Shift key while clicking on a relay button will toggle between selecting all 
relays of this module and deselecting all of them. 

OSP-B101 dialog 

When the dialog for operation of the R&S OSP-B101 module is opened, the actual 
relay setting of this module is read back from the hardware and displayed. 

The dialog as described above applies to further options of the R&S OSP as far as the 
option has got a similar relay configuration. It will apply to the following modules: 

Option Relay configuration 

OSP-B106 3 x SPDT relay with N connectors, 12 GHz,  
3 x SPDT relays with BNC connectors, 900 MHz / 2 A 

OSP-B107 6 x SPDT relay, solid state, 6 GHz 

OSP-B111 6 x SPDT relay, 40 GHz 

OSP-B127 6 x SPDT relay, solid state, terminated, 10 GHz 

OSP-B132 6 x SPDT relay with N connectors, 12 GHz 

Relay numbering 

Please note that for the module OSP-B106 the relays are numbered from K1 to K6 but 
from K11 to K16 for all other modules. 
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2.3.7 Controlling the R&S OSP-B102/-B112/-B128 

After selection of the R&S OSP-B102 module the following dialog is opened.  

The module R&S OSP-B102 contains two RF switches of SP6T type, which is shown 
in the OSP-B102 dialog. 

Clicking on any of the six positions of the two relays, this relay will switch to the 
associated terminal. Clicking on a closed position will open it and reset this relay. 

SP6T switch 

Note that for this type of relay only one terminal (1 of 6) can be activated at the same 
time. If no terminal is activated, the relay is in open position. 

The buttons K1 and K2 are not required for manual operation of the switches, but for 
defining a path configuration (see chapter 2.4). 

K1 A button K1 and/or K2 in grey color indicates that this relay is not selected. A non 
selected relay is not considered when defining a path configuration. 

K2 To take over particular relays into the path configuration, the relay buttons must be 
selected by clicking on each of the relay buttons required. The selected relay is 
displayed with a button in green color. All relays whose relay buttons are selected are 
taken over into a path configuration.  
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► Pressing the Shift key while clicking on a relay button will toggle between selecting 
all relays of this module and deselecting all of them. 

OSP-B102 dialog 

When the dialog for operation of the R&S OSP-B102 module is opened, the actual 
relay setting of this module is read back from the hardware and displayed. 

The dialog as described above applies to further options of the R&S OSP as far as the 
option has got the same relay configuration. It will apply to the following modules: 

Option Relay configuration 

OSP-B112 2 x SP6T relay, 40 GHz 

OSP-B128 Up 3 x SP6T relay, solid state, terminated, 10 GHz 

2.3.8 Controlling the R&S OSP-B103 

After selection of the R&S OSP-B103 module the following dialog is opened. 

The module R&S OSP-B103 contains two parallel ports, one with 16 output lines and 
one with 16 input lines. The OSP-B103 dialog shows both ports: 



R&S® OSP Getting Started 
OSP Panel Functions 

Quick Start Guide 1505.3896.12-09 39 

2.3.8.1 Setting the Output Pattern 

Clicking on one of the channel buttons in the output pattern field, the status of the 
output channel can be changed.  

1. An output channel marked in blue color indicates that the output channel is 
switched to low level (GND). Switching is performed on an active low signal, 
therefore the blue color indicates the active state. 

2. An output channel marked in white color indicates, that the output channel is in 
high impedance state. This is also the default after reset. 

3. To take over particular channels of the output port into the path configuration, the 
button left to the channels of the output pattern must be selected by clicking on 
each button of the required outputs. The selected output channel is displayed in 
green color. All output ports with selected (green) buttons are taken over into a 
path configuration.  

4. Pressing the Shift key while clicking on a relay button will toggle between selecting 
all relays of this module and deselecting all of them. 

5. Pressing this button sets the OPS-B103 outputs to the defined output pattern.  

6. The actual setting of the R&S OSP-B103 outputs now is displayed in the output 
pattern field (Ch1 to Ch16). 

7. The hexadecimal representation of the output pattern is displayed in the OSP-
B103 dialog, too. Ch1 corresponds to the lowest bit, having the value 1, whereas 
Ch16 is the highest bit, having the value 8000. 

OSP-B103 dialog 

When the dialog for operation of the R&S OSP-B103 module is opened, the actual 
output pattern setting of this module is read back from the hardware and displayed. 

I/O ports 

Note that for I/O ports the hardware specification must be observed when connecting 
external equipment. See chapter "Application of Module R&S OSP-B103" in the 
operating manual for further information. 

2.3.8.2 Reading the Input Pattern 

The input pattern of the R&S OSP-B103 can be read by one click. 

1. Pressing this button reads the input pattern of the OPS-B103  
The status of each input now is displayed in the input pattern field (Ch1 to Ch16). 
The hexadecimal representation of the input pattern is displayed in the OSP-B103 
dialog, too. Ch1 corresponds to the lowest bit, having the value 1, whereas Ch16 
is the highest bit, having the value 8000. 
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2. An input channel marked in blue color indicates that the input channel reads high 
level. 

3. An input channel marked in white color indicates that the input channel reads low 
level. 

OSP-B103 dialog 

When the dialog for operation of the R&S OSP-B103 module is opened, the actual 
input pattern of this module is read back from the hardware and displayed. 

2.3.9 Controlling the R&S OSP-B104/-B114 

After selection of the R&S OSP-B104 module the following dialog is opened.  

The module R&S OSP-B104 contains control for up to four external power relays. 
Furthermore, five output lines and four input lines of I/O ports are available, and there 
is some specific interlock functionality. The OSP-B104 dialog shows all these elements: 

See also chapter "R&S OSP-B104 Interface" in the operating manual for a detailed 
description of the interface. 
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The module R&S OSP-B114 only contains one built-in DPDT relay and offers four 
output lines. The other functions are the same as for the OSP-B104 module. 



R&S® OSP Getting Started 
OSP Panel Functions 

Quick Start Guide 1505.3896.12-09 42 

2.3.9.1 Setting the Transfer Relays 

Clicking to the symbol of the relay, the position of each relay can be toggled individually. In one 
position the connections are made between connectors 1 and 2 and between 3 and 4. In the 
other position the connections are made between connectors 1 and 4 and between 2 and 3. 

The buttons R1 up to R4 are not required for manual operation of the switches, but for 
defining a path configuration (see chapter 2.4). 

R1  Any button R1 up to R4 in grey color indicates that this relay is not selected. A non 
selected relay is not considered when defining a path configuration. 

R2  To take over particular relays into the path configuration, the relay buttons must be 
selected by clicking on each of the relay buttons required. The selected relay is 
displayed with a button in green color. All relays whose relay buttons are selected are 
taken over into a path configuration. 
Pressing the Shift key while clicking on a relay button will toggle between selecting all 
relays of this module and deselecting all of them. 

OSP-B104/-B114 dialog 

When the dialog for operation of the R&S OSP-B104 module is opened, the actual relay 
setting of this module is read back from the hardware and displayed. The information from 
the relay status is used, therefore also manual operation of the relay is recognized. 

As mentioned above, the actual status of the relays is read back from the relays itself 
via an additional contact (position contact). If this contact is not wired or does not close, 
the “faulty” status of a relay is marked by a red field at the relay number concerned. 
See following example. 

OSP-B104 relay status / delay time 

When the read back of the relay status on the OSP-B104 fails and is marked by a red 
field, the relay position contact and/or cabling needs to be checked. 
Note that the OSP-B104 relay delay time must be set in accordance to the relay data 
specification. If the delay time is too short, the relay status also may be shown as 
faulty. See chapter 4.2.4 for further information on the relay delay time. 
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2.3.9.2 Setting the Output Pattern 

 Clicking on one of the channel buttons in the output pattern field, the status of the 
output channel can be changed.  
An output channel marked in blue color indicates that the output channel is switched to 
low level (GND). Switching is performed on an active low signal, therefore the blue 
color indicates the active state. 
An output channel marked in white color indicates, that the output channel is in high 
impedance state. This is also the default after reset. 
To take over particular channels of the output port into the path configuration, the 
button left to the channels of the output pattern must be selected by clicking on each 
button of the required outputs. The selected output channel is displayed in green color. 
All output ports with selected (green) buttons are taken over into a path configuration. 
Pressing the Shift key while clicking on a relay button will toggle between selecting all 
relays of this module and deselecting all of them. 
Pressing this button sets the OPS-B104 outputs to the defined output pattern.  
The actual setting of the R&S OSP-B104 outputs now is displayed in the output pattern 
field (Ch1 to Ch5). 
The hexadecimal representation of the output pattern is displayed in the OSP-B105 
dialog, too. Ch1 corresponds to the lowest bit, having the value 1, whereas Ch5 is the 
highest bit, having the value 10. 
 

OSP-B104/-B114 dialog 
When the dialog for operation of the R&S OSP-B104 module is opened, the actual 
output pattern setting of this module is read back from the hardware and displayed. 

I/O ports 
Note that for I/O ports the hardware specification must be observed when connecting 
external equipment. See chapter "Application of Module R&S OSP-B103" in the 
operating manual for further information. 

2.3.9.3 Reading the Input Pattern 

The input pattern of the R&S OSP-B104/-B114 can be read by one click. 

1. Pressing this button reads the input pattern of the OPS-B104  
The status of each input now is displayed in the input pattern field (Ch1 to Ch4). 
The hexadecimal representation of the input pattern is displayed in the OSP-B104 
dialog, too. Ch1 corresponds to the lowest bit, having the value 1, whereas Ch4 is 
the highest bit, having the value 8. 

2. An input channel marked in blue color indicates that the input channel reads high level.

3. An input channel marked in white color indicates that the input channel reads low level.

OSP-B104/-B114 dialog 

When the dialog for operation of the R&S OSP-B104 module is opened, the actual 
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input pattern of this module is read back from the hardware and displayed. 

2.3.9.4 Reading the Interlock State 

The interlock state of the R&S OSP-B104 can be read by one click. 

Pressing this button reads the interlock state of the OPS-B104  
The status of the interlock, i.e. if there is a connection between pins 7 and 15 of the IN 
/ OUT connector, is indicated. A green signal shows a closed interlock, a red signal an 
open interlock. If the interlock is closed, a relay also closes a contact between pins 8 
and 14 of the IN / OUT connector. 

OSP-B104/-B114 dialog 

When the dialog for operation of the R&S OSP-B104 module is opened, the actual 
interlock status is read back from the hardware and displayed. 

2.3.10 Controlling the R&S OSP-B108 

After selection of the R&S OSP-B108 module the following dialog is opened.  

The module R&S OSP-B108 contains one switches of 4P6T type, which is shown in 
the OSP-B108 dialog. 

► Clicking on any of the six positions this relay will switch to the associated terminal. 
Clicking on a closed position will open it and reset this relay. 
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4P6T switch 

Note that for this type of relay only one terminal (1 of 6) can be activated at the same 
time. If no terminal is activated, the relay is in open position. 

The buttons K1 is not required for manual operation of the switches, but for defining a 
path configuration (see chapter 2.4). 

K1 A button K1 and/or K2 in grey color indicates that this relay is not selected. A non 
selected relay is not considered when defining a path configuration. 

K1 To take over particular relays into the path configuration, the relay buttons must be 
selected by clicking on each of the relay buttons required. The selected relay is 
displayed with a button in green color. All relays whose relay buttons are selected are 
taken over into a path configuration.  
Pressing the Shift key while clicking on a relay button will toggle between selecting all 
relays of this module and deselecting all of them. 

OSP-B108 dialog 

When the dialog for operation of the R&S OSP-B108 module is opened, the actual 
relay setting of this module is read back from the hardware and displayed. 

2.3.11 Controlling the R&S OSP-B131 

After selection of the R&S OSP-B131 module the following dialog is opened.  

The module R&S OSP-B131 contains two SPDT relays. 

 

Clicking to the symbol of the relay, the position of each relay can be toggled individually.  



R&S® OSP Getting Started 
Path Configuration 

Quick Start Guide 1505.3896.12-09 46 

SPDT switch 

Note that the terminal NC assigns the Normally Closed position. When the relay is not 
activated, terminal NC is connected to terminal C. 
The terminal NO is the Normally Open position. If the relay is activated, the terminal 
NO is connected to terminal C. 

The buttons K11 and K12 are not required for manual operation of the switches, but for 
defining a path configuration (see chapter 2.4). 

K12 Any button K11 and/or K12 in grey color indicates that this relay is not selected. A non 
selected relay is not considered when defining a path configuration.  

K11 To take over particular relays into the path configuration, the relay buttons must be 
selected by clicking on each of the relay buttons required. The selected relay is 
displayed with a button in green color. All relays whose relay buttons are selected are 
taken over into a path configuration. 
Pressing the Shift key while clicking on a relay button will toggle between selecting all 
relays of this module and deselecting all of them. 

OSP-B131 dialog 

When the dialog for operation of the R&S OSP-B131 module is opened, the actual 
relay setting of this module is read back from the hardware and displayed. 

2.4 Path Configuration 

A very comfortable way to define the different switching paths required in a test setup 
or in a system is the R&S OSP feature “path configuration”. This utility allows to 
combine several relay positions of different R&S OSP modules in one path information. 
The path can be named with a suitable name. If path switching is required, only the 
path configuration is called by its name and the switching is performed more or less by 
a single command. 

The advantage to make use of the OSP path configuration utility is: 

● The switching is called by logical name from the external application (for example 
EMC32 software). Using the logical name, the external application does not need 
to know the R&S OSP hardware configuration. 

● If the hardware configuration changes, it is sufficient to adapt the path 
configuration inside the R&S OSP. The external application does not need to be 
changed. 
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Choosing a default selection 

To obtain the correct switching for a new path configuration, it is recommended to start 
with a well-defined default selection. There are two possibilities: 

If the number of switches to be included in a path is rather small, it is recommended to 
deselect all switches. This is done by >Configure >Deselect all Switches.  

If the number of switches is rather large, use >Configure >Select all Switches instead. 

Don’t forget to select / deselect all switches which are not correctly selected by this 
default selection. 

2.4.1 Save a Path  

The path configuration is supported by the OSP Panel application. Refer to chapters 
2.2 and 2.3 for the installation and operation of the OSP Panel. 

To have a defined condition for the path switching, it is recommended to start with the 
R&S OSP in Reset condition. 

A path configuration may consist out of several relays located on different R&S OSP 
modules. Please note that the relay buttons in the corresponding dialogs must be 
selected for all relays which should be taken over in the path configuration. 
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In the above example, the relays K11 and K14 from module R&S OSP-B101 and the 
relay K2 from module R&S OSP-B102 will be saved as a path.. 

To define and save the path, proceed as follows: 

1. Select >Path >Save Path … in the OSP Panel. 

The following dialog will appear: 

The path configuration is named by default to “path_01”. A new name for the path 
configuration can be entered by overwriting the default name. 
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2. Pressing the button Save saves the path in the flash memory of the R&S OSP. 

The upper data field shows the existing paths which already are stored in the 
R&S OSP flash memory.  

3. Takes over the actual switching into the path and stores the path in the R&S OSP. 

4. Will exit the dialog 

Invalid path configurations 

When changing the hardware configuration of an OSP it may happen that a previously 
stored path no longer is applicable. For example, moving a module to a neighboring 
position and leaving the previous position empty will make all references to this slot invalid.

Whenever the OSP Panel encounters such an invalid path, it will display some warning 
message, and in addition the path name will be displayed in blue, giving some bare 
information about the included switches. 
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2.4.2  Switch a Path  

If a path has been defined as described in the previous chapter, the path can be 
switched as follows: 

1. Start the OSP Panel. 

2. Select >Path >Switch Path … in the OSP Panel. 

The following dialog appears: 

The left field shows the names of all path configurations which already have been defined. 
The highlighted path configuration will be switched when pressing the Switch button. 

The right field Path Definition shows all relays and settings related to the selected path. 
 
The selected path configuration will be switched; i.e. all the relays and outputs, 
respectively, which are part of the path, will be set to the defined position. 

Pressing this button will exit the dialog 
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2.4.3 Delete a Path 

If a path has been defined as described in the previous chapter, the path can be 
deleted as follows: 

1. Start the OSP Panel. 

2. Select >Path >Delete Path … in the OSP Panel. 

The following dialog appears: 

The field shows the names of all paths which already have been defined. The 
highlighted path configuration will be deleted when pressing the Delete button. 

The selected path will be deleted from the flash memory in the R&S OSP. 
The only possibility to recover a path which was unintentionally deleted is to use the 
Import Path function, assuming the path has been exported before.  

Pressing this button will exit the dialog 
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2.4.4 Export a Path 

If a path has been defined as described in the previous chapter, the path can be 
exported to a file as follows: 

1. Start the OSP Panel. 

2. Select >Path >Export Paths … in the OSP Panel. 

The following dialog appears: 

The list of path names contains all paths stored on the flash memory of the OSP. A 
tick in the leftmost column indicates which paths are currently selected in this 
dialog. Clicking into a line toggles selection and deselection of the path. By 
activating the check box below the list all paths can be selected or deselected at 
once. 

End of path selection, go to the following dialog. 

Pressing this button will exit the dialog. 

In the next dialog the directory is chosen where the files containing the path 
information are created.  
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With the usual Windows operation one can move throughout the files system in 
order to define the directory. By default the directory is the installation path of the 
OSP Panel. 

The file name selection in the lower part of the dialog has no meaning. Only the 
directory name in the field at the top of the dialog is used. 

The selected paths will be saved as files with the suffix “.txt” to the directory indicated. 

Pressing this button will exit the dialog  
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2.4.5 Import a Path 

If a path has been exported as described in the previous chapter, the path can be 
imported again. It is required that the OSP Panel is connected to an instrument.  

1. Start the OSP Panel. 

2. Select >Path >Import Paths … in the OSP Panel. 

The following dialog appears: 

This dialog allows to select all files which shall be imported and saved on the OSP. 
Once all required files are collected, pressing the OK button will start the import. 

Pressing the Add button moves the marked file to the list of selected files. With the 
standard Windows function a group of files can be selected at once: using the Shift key 
while clicking on a second file will mark all files between a first file and this one, and 
using the Ctrl key at the same time will add the second file as a marked one. 

Will exit the dialog 

The selected files will be imported and stored as paths to the R&S OSP flash memory.

The marked file will be removed from the list of selected files. 

All files will be removed from the list of selected files. 
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2.5 Sample Session 

The sample session shows a typical application of the R&S OSP and gives a guidance 
to the user how to solve the various switching tasks with the R&S OSP. 

2.5.1 Example Path Configuration 

The following example shows how to set up the path for a Microwave EMS system up 
to 18 GHz consisting of a signal generator, three amplifiers and a two-channel power 
meter. The following signal paths are required and have to be set dependent on the 
frequency range. 

● Generator output to amplifier input 
● Amplifier output forward power to power meter 
● Amplifier output reverse power to power meter 
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2.5.1.1 Defining the Path for PA1 

To have a defined condition for the path switching, it is recommended to start with the 
R&S OSP in Reset condition. 

Reset 

To obtain the correct switching for a new path configuration, it is recommended to reset 
the R&S OSP. Select in the OSP Panel >Configure >Deselect all Switches.

According to the above example, for amplifier PA1 the following paths are required: 

Signal path Required relay position 

Sig Gen to PA1 input R&S OSP-B101 / K11- NO 

PA1 Fwd to Power Meter Ch A R&S OSP-B102 / K1-1 

PA1 Fwd to Power Meter Ch B R&S OSP-B102 / K2-1 

Start the OSP Panel and make sure not to take over any undesired relay setting. Select 
therefore in the OSP Panel >Configure >Deselect all Switches.

After that, select the OSP-B101 dialog and set K11 to position NO. Do not forget to 
select the K11 button. 

Now select the OSP-B102 dialog and set K1 and K2 to position 1. Do not forget to 
select the K1 and K2 buttons. 

Now start the path configuration as follows: 

► Select >Path >Save Path … in the OSP Panel. 

The following dialog will appear: 

The upper data field shows the paths which are already stored in the R&S OSP. 
Type in the path name “Path_PA1” and press the button “Save”. 
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2.5.1.2 Defining the Path for PA2 

According to the above example, for amplifier PA2 the following paths are required: 

Signal path Required relay position 

Sig Gen to PA2 input R&S OSP-B101 / K11- NC, K12-NO 

PA2 Fwd to Power Meter Ch A R&S OSP-B102 / K1-2 

PA2 Fwd to Power Meter Ch B R&S OSP-B102 / K2-2 

Start the OSP Panel and make sure not to take over any undesired relay setting. Select 
therefore in the OSP Panel >Configure >Deselect all Switches.

After that, select the OSP-B101 dialog and set K11 to position NC and K12 to position 
NO. Do not forget to select the K11 and K12 buttons. 

Now select the OSP-B102 dialog and set K1 and K2 to position 2. Do not forget to 
select the K1 and K2 buttons. 

Now start the path configuration as follows: 

► Select >Path >Save Path … in the OSP Panel. 

The following dialog will appear: 

The upper data field shows the paths which are already stored in the R&S OSP. 
Type in the path name “Path_PA2” and press the button “Save”. 
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2.5.1.3 Defining the path for PA3 

According to the above example, for amplifier PA3 the following paths are required: 

Signal path Required relay position 

Sig Gen to PA3 input R&S OSP-B101 / K11- NC, K12-NC 

PA3 Fwd to Power Meter Ch A R&S OSP-B102 / K1-3 

PA3 Fwd to Power Meter Ch B R&S OSP-B102 / K2-3 

Start the OSP Panel and make sure not to take over any undesired relay setting. Select 
therefore in the OSP Panel >Configure >Deselect all Switches.

After that, select the OSP-B101 dialog and set K11 to position NC and K12 to position 
NC. Do not forget to select the K11 and K12 buttons. 

Now select the OSP-B102 dialog and set K1 and K2 to position 3. Do not forget to 
select the K1 and K2 buttons. 

Now start the path configuration as follows: 

► Select >Path >Save Path … in the OSP Panel. 

The following dialog will appear: 

The upper data field shows the paths which are already stored in the R&S OSP. 
Type in the path name “Path_PA3” and press the button “Save”. 

The path configuration now is stored in the OSP flash memory and is available for 
further use. 

2.5.2 Manual Setting of the Paths 

To set up the path for power amplifier PA 1, PA2 and PA3, respectively, only a simple 
step is required.  

► Select >Path >Switch Path … in the OSP Panel. 

The following dialog appears: 
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Select the path name Path_PA1, press the button “Switch” and all necessary 
switching for PA1 is done. 

For PA2 and PA3 proceed accordingly. 

The field Path Definition shows the relay setting of the selected path.  

The path definition also is shown in the OSP Panel system information. 

► Select >File >System Info … in the OSP Panel. For the above example, the 
following information is shown: 
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2.5.3 Remote Control Setting of the Path Configuration 

Once the required path configurations are stored in the R&S OSP, they are available by 
remote control applications like the R&S EMC32 software. 

The advantage to make use of the OSP path configuration utility is: 

● The switching is called by logical name from the external application (for example 
EMC32 software). Using the logical name, the external application does not need 
to know the R&S OSP hardware configuration. 

● If the hardware configuration has to be changed, only the path configuration inside 
the R&S OSP must be adapted. The external application does not need to be 
changed. 

For the above examples, the following strings are to be sent to the R&S OSP: 

ROUTE:CLOSE “Path_PA1” 
ROUTE:CLOSE “Path_PA2” 
ROUTE:CLOSE “Path_PA3” 

Further information on remote control functions are to be found in Chapters 5 and 6 in 
the operating manual. Information of applications together with the R&S EMC32 
software is available in chapter "OSP and EMC32 Software" in the operating manual. 
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3 Manual Operation 
The model R&S OSP120 is the version in the R&S OSP family which is operated 
remote controlled. There are no keys and display on the front panel for manual control. 
If an R&S OSP150 is connected to this OSP120, it is also controlled from there. 

See next chapter for kind of manual operation. 

The model R&S OSP130 is equipped with display and front panel keys for manual 
operation.  

3.1 Manual Operation of the Modules  

A “manual operation” of the instrument functions is achieved by the OSP Panel or 
using the graphical user interface (GUI) of the R&S OSP via Web-Browser (all models 
of OSP family).  

The model R&S OSP130 can be operated using the GUI together with the OSP130 
Display and keyboard.  

The application OSP Panel runs on an external computer with Windows Operating 
System. The external computer is connected to the R&S OSP via LAN network. 

See chapters 2.2 and 2.3 for installation and operation of the OSP Panel. 

Information how to run the GUI via Web-Browser are provided chapter 4.3.

Details to the manual operation of the R&S OSP130 are given in chapter 4.3.

3.2 R&S OSP Setups  

All setups which are necessary to perform in the Linux operating system, which is 
integral part of the R&S OSP120 or OSP130, are to be done via external keyboard and 
external monitor (not for OSP130). 

See chapter 1.7.2 and 1.7.3 of this manual how to connect these accessories. 

Chapter 1.10 gives an example for Linux related actions. 
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4 Instrument Functions 
The following chapter describes the instrument functions of the R&S OSP. The basic 
instrument R&S OSP is the Platform for Switching and Control Purpose which is 
completed by several options. The function of the instrument depends on the options 
(R&S OSP modules) which are fitted in the instrument. 

As an overview and for better understanding of the instrument function and the 
configuration possibilities, the following chapter shows block diagrams of the 
R&S OSP. 

Then there is a description of the available modules for the R&S OSP and their 
function. 

Basic instrument functions like selftest and configuration information are described as well.  

4.1 R&S OSP Instrument Frame 

The R&S OSP is designed as a 19” unit with two height units. The instruments 
R&S OSP120 and R&S OSP130 can remotely be controlled via LAN interface.  

The R&S OSP120 contains no front elements for manual operation and is therefore 
only to be used in remote operation.  

The R&S OSP130 can operate as a stand-alone instrument thus not requiring remote 
control. Front panel keys and a display allow local operation. It may also be integrated 
in remotely controlled systems.  

The R&S OSP150 is an extension of the OSP120 or OSP130 allowing more modules 
to be used. It is connected via CAN bus connected to the rear side of the R&S OSP. 

The R&S OSP unit has no switching functions as long as no R&S OSP modules are 
installed.  

Depending on the model, the R&S OSP frame unit can consist of the following blocks: 

● Computer LPC8 (Low Profile Controller) 
● Mainboard 
● Power supply 
● Interface for USB/DVI 
● Front panel with function keys and a color display screen 

Switching functions are added to the R&S OSP frame unit by installation of R&S OSP 
modules. The R&S OSP offers three slots for installation of R&S OSP modules. The 
modules are installed from the rear side of the instrument. A maximum of three 
R&S OSP modules can be configured.  
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4.1.1 R&S OSP Block Diagram 

The following block diagram shows the main functional groups of the R&S OSP120. 

Figure 1 Block Diagram R&S OSP120 

The central part of the R&S OSP frame is the Low Profile Controller LPC8 with Linux 
Operating System. The computer handles the external interfaces of the R&S OSP120 
such as LAN, USB and DVI. It also serves the internal interfaces in the R&S OSP120 
like the control ports for the three slots which can take the R&S OSP modules.  

The single board computer is plugged onto the R&S OSP Main Board. The basic 
component on the mainboard is an FPGA which supplies all necessary interfaces 
between computer PCI Bus and R&S OSP internal interfaces like the control ports for 
the R&S OSP modules. The CAN bus which is used to connect further R&S OSP 
extension units is implemented in the FPGA as well. 

The power is supplied by a 175 W switching type power supply. The supply voltage 
for the R&S OSP modules and their relays is generated by a voltage converter which is 
placed on the Main Board.  

Via a small interface board the connectors of the Low Profile Controller are adapted to 
the standard interfaces to connect USB devices and the DVI monitor. 
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The next block diagram shows the main functional groups of the R&S OSP130. 

Figure 2 Block Diagram R&S OSP130 

Additional to the OSP120, in the OSP130 the connection to the front side display unit 
and keys is available for local operation. No connection to an external monitor is 
available. 

Finally, the block diagram of the OSP150 extension unit shows its main functional 
blocks: 

Figure 3 Block Diagram R&S OSP150 
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4.1.2 R&S OSP Module Slots 

The R&S OSP offers three slots for installation of R&S OSP modules. The modules are 
installed from the rear side of the instrument. A maximum of three R&S OSP modules 
can be configured. If more R&S OSP modules are required, the R&S OSP can be 
extended by the version R&S OSP150. The extension unit R&S OSP150 is controlled 
from the R&S OSP120 or OSP130 by CAN bus Interface.  

Refer to chapter "OSP Drivers" in the operating manual for detailed information on the 
extension unit R&S OSP150. 

Slot A11 Slot A12 Slot A13 
Figure 4 R&S OSP Module Slots 

The slots are designated with A11, A12 and A13. The same order is used when 
addressing the modules; i.e. R&S OSP module 1 corresponds to slot A11 etc. 

In principle the R&S OSP modules can be installed in the slots in any order. A slot 
which is not occupied will be shown as empty by the OSP Panel application.  

Module Slots 
The depth of the module slot A11 is limited. Only modules with a depth < 70 mm like 
the modules R&S OSP-B101, R&S OSP-B102, R&S OSP-B103, R&S OSP-B107, 
R&S OSP-B111 or R&S OSP-B112 can be operated in this slot!  
R&S OSP-B106 can be placed in slots A11+ A12 or A12 + A13. 

For installation of the modules see the corresponding installation procedures. 

4.1.3 R&S OSP120 Version12 and Module Slots 

The R&S OSP120 Version 12 is designed with two slots in the front side in addition to 
the three slots at the rear side as described above.  

Slot A12F Slot A13F 

Figure 5 R&S OSP120 Version12  Module Slots at front side 
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Standard Configuration: 

The slots in the front side are designated with A12F and A13F. For installation of 
modules, the following order is defined as standard: 

The first module installed from OSP front side always is mounted in slot A13F. From 
interface point of view it corresponds to slot A13 (connected via cable W7 – see figure 
below).  

The second module installed from OSP front side is mounted in slot A12F. From 
interface point of view it corresponds to slot A12 (connected via cable W6 – see figure 
below). 

Figure 6 Block Diagram R&S OSP120 Var. 12 

Configuration of 2-slot modules: 

OSP modules with 2-slot size and requiring two interface cables W6 and W7 (like the 
modules OSP-B105/-B115/-B125/-B126) only can be mounted in A12/A13 or 
A12F/A13F. 

That means with a 2-slot module configured in A12/A13 and one module configured in 
the OSP front side, only interface cable W5 (corresponding to A11) is left for A13F). 
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4.1.4 R&S OSP120 Version12 and Modules OSP-B011/-B012 

Configuring a system with instruments having the RF connectors at the front panel, the 
cabling will be made easy having the RF connectors at the OSP120 front side as well. 
The R&S OSP120 Version 12 is designed with two slots in the front side of the in 
addition to the three slots at the rear side. Two slots therefore can be used for 
mounting the options OSP-B011 and/or OSP-B012. See following diagram. 

Figure 7 Block Diagram R&S OSP120 Var. 12 

Installation of Module Panels OSP-B011/-B012 

Note that the length of the cable sets OSP-Z010/-Z011/-Z012 is limited for a maximum 
offset of one module only. That means if one Module Panel is mounted in the slot A13F 
at the OSP front side, a second Module Panel for example can be installed at the OSP 
rearside in any one of the three available slots (offset ≤ 1 slot). 

But it is not possible to mount one Module Panel in the slot A12F at the OSP front side 
and a second Module Panel at the OSP rearside in slot A11 (offset > 1 slot)! 

4.1.4.1  Module Panel OSP-B011 

The module OSP-B011 is a panel (1-slot size) prepared to be fitted with up to twelf 
coaxial feed-through connectors SMA-female; see below picture. 
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Slot A12F Slot A13F 

Figure 8 R&S OSP-B011 module panel 

For cabling the options OSP-Z11 or Z12 are required. See chapter 4.1.4.3 for details. 

4.1.4.2 Module OSP-B012 

The module OSP-B012 is a panel (1-slot size) prepared to be fitted with up six coaxial 
feed-through connectors N-female; see below picture. 

Slot A12F Slot A13F 

Figure 9 R&S OSP-B011 module panel 

For cabling the options OSP-Z11 or Z12 are required. See chapter 4.1.4.3 for details. 

4.1.4.3 Cable sets OSP-Z010/-Z011/-Z012 

The modules OSP-B011 and/or OSP-B012 can be connected using the cable sets and 
configurations as shown in the below table. 

Module 
Panel 1 

Module 
Panel 2 

Required 
Cable Set 

 

OSP-B011 OSP-B011 max 3 x 
OSP-Z010 

OSP-B012 OSP-B011 OSP-Z011 

OSP-B012 OSP-B012 OSP-Z012 
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All Cable Sets consist out of four coaxial cables fitted with suitable coaxial connectors. 
The coaxial connectors are bulkhead connector types with round flange. They are fed 
through the Module panels from rear-side and fixed wuth the cenztral screw. 

This way it is not required to open the OSP instrument to mount the options OSP-
B010/-B011 and/or –B012 together with the related cable sets.  

4.2 Module Functions 

As already mentioned, the switching capability is added to the R&S OSP by installation 
of an R&S OSP module. For the different kind of switching applications, a series of 
R&S OSP modules is available. 

The following chapters describe the function of the R&S OSP modules.  

4.2.1 RF Switch Module R&S OSP-B101/-B107/-B111/-B127 

The module R&S OSP-B101 and similar as listed above consists of six SPDT switches. 
All six switches can be operated independently from each other. 

The relay is a failsafe type; i.e. an RF connection is provided from the terminal C 
(Common) to the position NC (normally closed) with no voltage applied to the relay. To 
maintain an RF connection between the terminal C (Common) and the position NO 
(normally open), a continuous voltage is to be applied to the relay. 

Figure 10 Module R&S OSP-B101 

The relays are mounted directly in the R&S OSP-B101 front panel. All the RF 
connectors are SMA female types. All relays are soldered into a printed circuit board; 
this way the module is of compact size and no cabling to the relays is required.  

The R&S OSP-B101 module is supplied and controlled from the R&S OSP via a single 
connector on the R&S OSP-B101 printed circuit board. The connection to the 
R&S OSP is done via a single connection cable. 

The R&S OSP-B101 module is equipped with an on-board memory to store the 
necessary configuration data of the module.  
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Figure 11 Block Diagram Module R&S OSP-B101 

When the module R&S OSP-B101 is configured within the R&S OSP, a manual operation 
of the module can be performed via the OSP Panel. See chapter 2.3.6 for details. 
For remote control operation see chapters 5 and 6 in the operating manual. 

Depending on the required switching application, several modules of the R&S OSP-
B101 type can be installed in one R&S OSP. 

In the R&S OSP frame a maximum of three modules is possible. If more than three 
modules are required, the extension unit R&S OSP150 must be used. For further 
information on the extension unit R&S OSP150 see chapter "OSP Drivers" in the 
operating manual.  

The description above applies to further options of the R&S OSP as far as the option 
has got a similar relay configuration. It will apply to the following modules: 

Option Relay configuration 

OSP-B107 6 x SPDT relay, solid state, 6 GHz 

OSP-B111 6 x SPDT relay, 40 GHz 

OSP-B127 6 x SPDT relay, solid state, terminated, 10 GHz 

4.2.2 RF Switch Module R&S OSP-B102/-B112/-B128 

The module R&S OSP-B102 and similar as listed above consists of two SP6T 
switches. Both switches can be programmed independently from each other. 

The relay is a failsafe type; i.e. no RF connection is provided from the terminal C 
(Common) to one of the six terminals when no voltage is applied to the relay. To maintain 
an RF connection between the terminal C (Common) and one of the six output terminals, a 
continuous voltage is to be applied to the corresponding power terminal of the relay. 
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Note that always one out of the six terminals of the relays is allowed to be activated at 
the same time. When operating the R&S OSP-B102 inside the R&S OSP, the 
R&S OSP firmware takes care for correctly switching the SP6T relay. 

Figure 12 Module R&S OSP-B102 

The relays are mounted directly in the R&S OSP-B102 front panel. All the RF 
connectors are SMA female types. All relays are soldered into a printed circuit board; 
this way the module is of compact size and no cabling to the relays is required.  

The R&S OSP-B102 module is supplied and controlled from the R&S OSP via a single 
connector on the R&S OSP-B102 printed circuit board. The connection to the 
R&S OSP is done via a single connection cable. 

The R&S OSP-B102 module is equipped with an on-board memory to store the 
necessary configuration data of the module. 

Figure 13 Block Diagram Module R&S OSP-B102 

When the module R&S OSP-B102 is configured within the R&S OSP, a manual operation 
of the module can be performed via the OSP Panel. See chapter 2.3.7 for details. 

For remote control operation see chapters 5 and 6 in the operating manual. 

Depending on the required switching application, several modules of the R&S OSP-
B102 type can be installed in one R&S OSP. 

In the R&S OSP frame a maximum of three modules is possible. If more than three 
modules are required, the extension unit R&S OSP150 must be used. For further 
information on the extension unit R&S OSP150 see chapter "OSP Driver" in the 
operating manual. 
The description above applies to further options of the R&S OSP as far as the option 
has got a similar relay configuration. It will apply to the following modules: 
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Option Relay configuration 

OSP-B112 2 x SP6T relay, 40 GHz 

The module R&S OSP-B128 can be configured with up to three SP6T relays. The relay 
configuration is with all SMA connectors in-line (flat relay design). See the following picture. 

Figure 14a Module R&S OSP-B128 

The actual number of SP6T relays fitted in the OSP-B128 can be read from the module 
via I2C interface. The R&S OSP automatically recognizes the actual configuration. 

Please note that the relays always must be configured starting from position K1 
onwards. In the above picture two relays are fitted; the openings for K3 are covered by 
a sheet metal strip. 

4.2.3  I/O Module R&S OSP-B103 

The module R&S OSP-B103 is a digital I/O module consisting of a 16 bit input and a 
16 bit output port. 

The input ports are available on the upper D-Sub connector. The input port can be read 
at any time. Each input is protected with low-pass and diode against transients.  

The output ports are accessible on the lower D-Sub connector. Each output channel is 
designed as a FET driver switching to GND when activated. Each output is protected 
with diode against transients which may occur when switching inductive loads such as 
relay coils.  

All output lines can be programmed independently from each other. 

Figure 15 Module R&S OSP-B103 
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The R&S OSP-B103 module is supplied and controlled from the R&S OSP via a single 
connector on the R&S OSP-B103 printed circuit board. The connection to the 
R&S OSP is done via a single connection cable. 

The R&S OSP-B103 module is equipped with an on-board memory to store the 
necessary configuration data of the module. 

Figure 16 Block Diagram Module R&S OSP-B103 

When the module R&S OSP-B103 is configured within the R&S OSP, a manual 
operation of the module can be performed via the OSP Panel. See chapter 2.3.8 for 
details. 
For remote control operation see chapters 5 and 6 in the operating manual. 

See chapter "R&S OSP-B103 Interface" in the operating manual for details on the 
connector pin assignments. 

Depending on the required application, several modules of the R&S OSP-B103 type 
can be installed in one R&S OSP. 

In the R&S OSP frame a maximum of three modules is possible.If more than three 
modules are required, the extension unit R&S OSP150 must be used. For further 
information on the extension unit R&S OSP150 see chapter "OSP Driver" in the 
operating manual. 
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4.2.4 I/O Module R&S OSP-B104 

The module R&S OSP-B104 is a digital I/O module for special applications in EMS 
measurements. 

Figure 17 Module R&S OSP-B104 

It consists of input / output ports allowing control of up to four external power transfer 
relays, models Spinner BN 51 26 70 (7-16 connectors) or BN 64 00 75 (EIA 1 5/8” 
flange connectors). In addition, some lines of the ports are made available at an IN / 
OUT connector.  

Transfer switch 

The transfer relays are switched by control lines exhibiting a pulse rather than a constant 
level. For that reason two lines are required to set the switch to each position. Note that the 
state of the switch does not change state when the R&S OSP is turned on (reset condition).

The Spinner transfer relays support the “carrier safety contact” concept. While turning 
from one position to the other, this contact opens. If included in the interlock, the power 
amplifier connected to the interlock control will be deactivated while the relay is turning. 
In the final position the carrier safety contact closes again, thus closing the full interlock 
chain. The power amplifier then can also be put into operate mode again. 

The relays have a contact indicating the position. This line is read from the module and 
used to display and verify the current status.  

Delay time for Transfer switch 

The transfer relays may have a settling time which cannot be neglected. Per default a 
delay time of 100 msec is set up for the OSP-B104 module. The delay time allows the 
relay to reach it’s final position before the new position is read back. Refer to chapter 
6.4.3 for further information on how to change the delay time for the OSP-B104 relays.

In the lower part of the module, on the outside of the lower RELAY connectors, there 
are four LEDs labeled PWR 1 to PWR 4. If an LED shows a green light, the power is 
OK. If the LED is off, there is a problem with the power on the corresponding 
connector. In such a case, please turn off the OSP, try to correct for a possible fault in 
the cabling or connected relay, turn the OSP back on and check the LED again. 

In the middle between the lower RELAY connectors there are two more LEDs. The 
upper of the two is labeled PWR I/O and gives a status information on the power for 
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the I/O connector. If the LED shows a green light, the power is OK. If the LED is off, 
there is a problem with the power on the corresponding connector. In such a case, 
please turn off the OSP, try to correct for a possible fault in the cabling or the 
connected device, turn the OSP back on and check the LED again.  

The LED below indicates the status of the interlock (pins 7 and 15). If there is no 
connection between these two pins, or if any of the RELAY connectors does not 
connect its pins 3 and 4 (bridge at the connector or carrier safety status of the 
connected relay), the LED will show a red light indicating an open interlock. The LED 
being off indicates that the interlock is closed.  

The input ports are available on the upper D-Sub connector IN / OUT. The input port 
can be read at any time. Each input is protected with low-pass and diode against 
transients.  

The output ports are also accessible on the upper D-Sub connector IN / OUT. Each 
output channel is designed as a FET driver switching to GND when activated. Each 
output is protected with diode against transients which may occur when switching 
inductive loads such as relay coils. All output lines can be programmed independently 
from each other. 

The R&S OSP-B104 module is supplied and controlled from the R&S OSP via one 
supply and one control connector on the R&S OSP-B104 printed circuit board. The 
connection to the R&S OSP is done via those two connection cables. 

The R&S OSP-B104 module is equipped with an on-board memory to store the 
necessary configuration data of the module. 

Figure 18 Block Diagram Module R&S OSP-B104 
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When the module R&S OSP-B104 is configured within the R&S OSP, a manual 
operation of the module can be performed via the OSP Panel. See chapter 2.3.9 for 
details. 

For remote control operation see chapters 5 and 6 in the operating manual. 
See chapter "R&S OSP-B104 Interface" in the operating manual for details on the 
connector pin assignments. 

Depending on the required application, several modules of the R&S OSP-B104 type 
can be installed in one R&S OSP. 

In the R&S OSP frame a maximum of two modules is possible, due to the size of the 
module it only can be installed in slots A12 or A13. If more than two modules are 
required, the extension unit R&S OSP150 must be used. For further information on the 
extension unit R&S OSP150 see chapter "OSP Driver" in the operating manual..

4.2.5 RF Switch Module R&S OSP-B106/-B132 

The module R&S OSP-B106 consists of three SPDT switches with N connectors and 
three SPDT switches with BNC connectors.  

All six switches can be operated independently from each other. 

The relays are a failsafe type; i.e. an RF connection is provided from the terminal C 
(Common) to the position NC (normally closed) with no voltage applied to the relay. To 
maintain an RF connection between the terminal C (Common) and the position NO 
(normally open), a continuous voltage is to be applied to the relay. 

Figure 19 Module R&S OSP-B106 

The relays are mounted directly in the R&S OSP-B106 front panel. Three of the relays 
(K1 to K3) have N type connectors and are suited for frequencies up to 12 GHz. The 
other three (K4 to K6) have BNC connectors and may be used up to 900 MHz or for 
DC currents of up to 2 A at a maximum voltage of 30 V. There are no additional RF 
cables inside the module. 

The R&S OSP-B106 module is supplied and controlled from the R&S OSP via a single 
connector on the R&S OSP-B106 printed circuit board. The connection to the 
R&S OSP is done via a single connection cable. 

The R&S OSP-B106 module is equipped with an on-board memory to store the 
necessary configuration data of the module.  
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Figure 20 Block Diagram Module R&S OSP-B106 

When the module R&S OSP-B106 is configured within the R&S OSP, a manual operation 
of the module can be performed via the OSP Panel. See chapter 2.3.6 for details. 
For remote control operation see chapters 5 and 6 in the operating manual. 
See chapter "R&S OSP-B106 Interface" in the operating manual for details on the 
connector pin assignments. 

The module OSP-B106 has a double width. Therefore only one module can be 
installed in one R&S OSP frame. If more than one module is required, the extension 
unit R&S OSP150 must be used. For further information on the extension unit 
R&S OSP150 see chapter "OSP Driver" in the operating manual. 
The description above applies to further options of the R&S OSP as far as the option 
has got a similar relay configuration. It will apply to the following modules: 

Option Relay configuration 

OSP-B132 6 x SPDT relay with N-Connectors, 12 GHz 

4.2.6 DC MUX Module R&S OSP-B108 

The module R&S OSP-B108 is a four pole one to six multiplexer for DC. 
It is controlled equivalent to first Relay K11 of R&S OSP-B102. 

Figure 21 Module R&S OSP-B108 
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The R&S OSP-B108 module is supplied and controlled from the R&S OSP via a single 
connector on the R&S OSP-B108 printed circuit board. 

4.2.7 RF Switch Module OSP-B121 

The module R&S OSP-B121 is designed as a universal switching module using 
terminated RF relays. The OSP-B121 contains the following relay configuration: 

● 3 x SPDT switches (terminated) 

The module is designed for independent control of all relay. 

The relay is a failsafe type; i.e. a RF connection is provided from the terminal C 
(Common) to the position NC (normally closed) with no voltage applied to the relay. To 
maintain a RF connection between the terminal C (Common) and the position NO 
(normally open), a continuous voltage is to be applied to the relay. 

Figure 22 Module OSP-B121 

The relays are mounted directly in the OSP-B121 front panel. All the RF connectors 
are SMA female types. All relays are connected via a short cable to a printed circuit 
board; this way the module is of compact size.  

The OSP-B121 module is supplied and controlled from the OSP 120 via a single 
connector on the OSP-B121 printed circuit board. The connection to the OSP 120 is 
done via a single connection cable. 

The OSP-B121 module is equipped with a on board memory to store the necessary 
configuration data of the module. 
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Figure 23 Block diagram Module OSP-B121 

When the module OSP-B121 is configured within the OSP 120, a manual operation of 
the module can be performed via the OSP Panel. See chapter 2.2.5 for details. 
For Remote Control operation see chapter 5 and 6 in the operating manual 

Depending on the required switching application, several modules of the OSP-B121 
type can be installed in one OSP 120. 

In the OSP frame a maximum of three modules is possible. If more than three modules 
are required, the extension unit OSP 150 must be used. For further information on the 
extension unit OSP 150 see chapter 7.2 in the operating manual. 

4.2.8 RF Switch Module OSP-B122 

The module R&S OSP-B122 is designed as a universal switching module using 
terminated RF relays. The OSP-B122 contains the following relay configuration: 

● 1 x SP6T switch (terminated) 

The relay is a failsafe type; i.e. no RF connection is provided from the terminal C 
(Common) to one of the six terminals when no voltage is applied to the relay. To maintain a 
RF connection between the terminal C (Common)  and one of the six output terminals, a 
continuous voltage is to be applied to the corresponding power terminal of the relay. 

Note that always one out of the six terminals of the relays is allowed to be activated at 
the same time. When operating the OSP-B122 inside the OSP, the OSP firmware takes 
care for correct switching of the SD6T relay. 



R&S® OSP Instrument Functions 
Module Functions 

Quick Start Guide 1505.3896.12-09 80 

Figure 24 Module OSP-B122 

The relay is mounted directly in the OSP-B122 front panel. All the RF connectors are 
SMA female types. The relay is connected via a short cable to a printed circuit board; 
this way the module is of compact size.  

The OSP-B122 module is supplied and controlled from the OSP 120 via a single 
connector on the OSP-B122 printed circuit board. The connection to the OSP 120 is 
done via a single connection cable. 

The OSP-B122 module is equipped with a on board memory to store the necessary 
configuration data of the module. 

Figure 25 Block diagram Module OSP-B122 

When the module OSP-B122 is configured within the OSP 120, a manual operation of 
the module can be performed via the OSP Panel. See chapter 2.2.5 for details. 

For Remote Control operation see chapter 5 and 6 in the operating manual. 

Depending on the required switching application, several modules of the OSP-B122 
type can be installed in one OSP 120. 

In the OSP frame a maximum of three modules is possible. If more than three modules 
are required, the extension unit OSP 150 must be used. For further information on the 
extension unit OSP 150 see chapter "OSP Driver" in the operating manual. 
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4.2.9 RF Switch Module OSP-B123 and OSP-B124 

The module R&S OSP-B123/124 is designed as a universal switching module using 
terminated RF relays. The OSP- B123/124 contains the following relay configuration: 

OSP-B123 OSP-B124 

● 6 x SPDT switches (terminated) ● 3 x SPDT switches (terminated) 
● 1 x SP6T switch (terminated) ● 2 x SP6T switch (terminated) 

The module is designed for independent control of all relay. 

The relay is a failsafe type. In case of the SP6T relay, no RF connection is provided 
from the terminal C (Common)  to one of the six terminals when no voltage is applied 
to the relay. To maintain a RF connection between the terminal C (Common)  and one 
of the six output terminals, a continuous voltage is to be applied to the corresponding 
power terminal of the relay. 

In case of the SPDT relay, a RF connection is provided from the terminal C (Common) 
to the position NC (normally closed) with no voltage applied to the relay. To maintain a 
RF connection between the terminal C (Common) and the position NO (normally 
open), a continuous voltage is to be applied to the relay. 

Note that for the SP6T relay only one out of the six terminals is allowed to be activated 
at the same time. When operating the OSP- B123/124 inside the OSP, the OSP 
firmware takes care for correct switching of the SD6T relay. 

Figure 26 Module OSP-B123 
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Figure 27 Module OSP-B124 

All relays are is mounted directly in the OSP- B123/124 front panel. All the RF 
connectors are SMA female types. All relays are connected via a short cable to a 
printed circuit board; this way the module is of compact size.  
The OSP- B123/124 module is supplied and controlled from the OSP 120 via a single 
connector on the OSP- B123/124 printed circuit board (OSP-B123 has got two boards). 
The connection to the OSP 120 is done via one (OSP-B123) or two (OSP-B124) 
connection cables. 
The OSP- B123/124 module is equipped with a on board memory to store the 
necessary configuration data of the module. 

Figure 28 Block diagram Module OSP-B123 
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Figure 29 Block diagram Module OSP-B124 

When the module OSP- B123/124 is configured within the OSP 120, a manual 
operation of the module can be performed via the OSP Panel. See chapter 2.2.5 for 
details. 
For Remote Control operation see chapter 5 and 6  in the operating manual. 

The OSP- B123/124 is a two-slot module. Within one OSP 120 only one module of this 
type can be installed. 

The OSP frame offers a maximum of three slots. If more than one OSP- B123/124 are 
required, the extension unit OSP 150 must be used. For further information on the 
extension unit OSP 150 see chapter "OSP Driver" in the operating manual. 

4.2.10 RF Switch Module OSP-B125 and OSP-B126 

The module R&S OSP-B125/126 is designed as a universal switching module using 
terminated RF relays. The OSP- B125/126 contains the following relay configuration: 

OSP-B125 OSP-B125 

● 6 x SPDT switches (terminated) ● 3 x SP6T switch (terminated) 
● 3 x SP6T switch (terminated)  

The module is designed for independent control of all relay. 

The relay is a failsafe type. In case of the SP6T relay, no RF connection is provided 
from the terminal C (Common)  to one of the six terminals when no voltage is applied 
to the relay. To maintain a RF connection between the terminal C (Common)  and one 
of the six output terminals, a continuous voltage is to be applied to the corresponding 
power terminal of the relay. 
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In case of the SPDT relay, a RF connection is provided from the terminal C (Common) 
to the position NC (normally closed) with no voltage applied to the relay. To maintain a 
RF connection between the terminal C (Common) and the position NO (normally 
open), a continuous voltage is to be applied to the relay. 

Note that for the SP6T relay only one out of the six terminals is allowed to be activated 
at the same time. When operating the OSP- B125/126 inside the OSP, the OSP 
firmware takes care for correct switching of the SD6T relay. 

Figure 30 Module OSP-B125 

Figure 31 Module OSP-B126 

All relays are is mounted directly in the OSP- B125/126 front panel. All the RF 
connectors are SMA female types. All relays are connected via a short cable to a 
printed circuit board; this way the module is of compact size.  

The OSP- B125/126 module is supplied and controlled from the OSP 120 via two 
printed circuit boards mounted on the OSP- B125/126. The connection to the OSP 120 
is done via a two connection cables. 

The OSP- B125/126 module is equipped with a on board memory to store the 
necessary configuration data of the module. 
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Figure 32 Block diagram Module OSP-B125 

Figure 33 Block diagram Module OSP-B126 

When the module OSP- B125/126 is configured within the OSP 120, a manual operation of 
the module can be performed via the OSP Panel. See chapter 2.2.5 for details. 
For Remote Control operation see chapter 5 and 6 in the operating manual. 

The OSP- B125/126 is a three-slot module. Within one OSP 120 only one module of 
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this type can be installed. 

If more than one OSP- B125/126 are required, the extension unit OSP 150 must be 
used. For further information on the extension unit OSP 150 see chapter "OSP Driver" 
in the operating manual. 

4.2.11 Module OSP-B114 for EMS application 

The module R&S OSP-B114 is intended for applications in small or medium systems 
for Electromagnetic Susceptibility (EMS). The module fulfills the following tasks: 

● Switching of the output of two power amplifiers to one or two transmit antennas (or 
other kind of transducers). 

● Providing the circuitry for an interlock loop with the following functions: 
- monitoring a interlock loop and read/display the actual status 
- power down external amplifiers depending on interlock status 
- disconnect the signal generator from power amplifier (if they cannot be 

powered down) depending on interlock status  

● Four output lines. Can be used to control the polarization of the transmitting 
antennas 

● Four input lines  

Figure 34 Module OSP-B114 

The relay K1 with N-connectors is a DPDT type. When not activated (no voltage 
applied to the relay) and after Reset, the terminals 1 - 2 and 3 - 4 are connected. 
When activated, the terminals 1 - 3 and 2 -4 are connected. 

The SPDT relay (K5) with SMA connectors is controlled by the interlock. With interlock 
loop open, a RF connection is provided from the terminal C (Common) to the position 
NC (normally closed). 
With interlock loop closed, a RF connection is provided between the terminal C 
(Common) and the position NO (normally open). 

The interlock status is shown by the red LED on the module front panel, too. 

Red LED switched on � Interlock loop is open 
switched off � Interlock loop is closed  
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Figure 35 Block diagram Module OSP-B114 

When the module R&S OSP-B114 is configured within the R&S OSP, a manual operation 
of the module can be performed via the OSP Panel. See chapter 2.3.9 for details. 

For remote control operation see chapters 5 and 6 in the operating manual. 
For details in the application of this module see chapter 7.6 
See chapter "R&S OSP-B114 Interface" in the operating manual for details on the 
connector pin assignments. 

4.2.12 RF Switch Module OSP-B131 

The module R&S OSP-B131 is designed for high power RF switching. The OSP-B131 
contains the following relay configuration: 

● 2 x SPDT switches with N-connectors 

The module is designed for independent control of both relays. 

The relay is a failsafe type; i.e. a RF connection is provided from the terminal C 
(Common) to the position NC (normally closed) with no voltage applied to the relay. To 
maintain a RF connection between the terminal C (Common) and the position NO 
(normally open), a continuous voltage is to be applied to the relay. 

Figure 36 Module OSP-B131 
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The relays are mounted directly in the OSP-B131 front panel. All the RF connectors 
are N female types. All relays are connected via a short cable to a printed circuit board; 
this way the module is of compact size.  

The OSP-B131 module is supplied and controlled from the OSP 120 via a single 
interface connector on the OSP-B131 printed circuit board. The connection to the OSP 
120 is done via a single connection cable. 

The OSP-B131 module is equipped with a on board memory to store the necessary 
configuration data of the module. 

Figure 37 Block diagram Module OSP-B131 

When the module OSP-B131 is configured within the OSP 120, a manual operation of 
the module can be performed via the OSP Panel. See chapter 2.2.5 for details. 
For Remote Control operation see chapter 5 and 6 in the operating manual. 

Depending on the required switching application, several modules of the OSP-B131 
type can be installed in one OSP 120. 

In the OSP frame a maximum of three modules is possible. If more than three modules 
are required, the extension unit OSP 150 must be used. For further information on the 
extension unit OSP 150 see chapter "OSP Driver" in the operating manual. 

4.2.13 RF Switch Module OSP-B129 

The module R&S OSP-B129 is designed as a universal switching module using one 
terminated SP8T relay and two SPDT relays. 
The module is designed for independent control of all relay. 

The relay is a failsafe type. In case of the SP8T relay, no RF connection is provided 
from the terminal C (Common)  to one of the six terminals when no voltage is applied 
to the relay. To maintain a RF connection between the terminal C (Common)  and one 
of the six output terminals, a continuous voltage is to be applied to the corresponding 
power terminal of the relay. 

In case of the SPDT relay, a RF connection is provided from the terminal C (Common) 
to the position NC (normally closed) with no voltage applied to the relay. To maintain a 
RF connection between the terminal C (Common) and the position NO (normally 
open), a continuous voltage is to be applied to the relay. 
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Note that for the SP8T relay only one out of the eight terminals is allowed to be 
activated at the same time. When operating the OSP- B129 inside the OSP, the OSP 
firmware takes care for correct switching of the SD8T relay. 

Figure 38 Module OSP-B129 

All relays are mounted directly in the OSP- B129 front panel. All the RF connectors are 
SMA female types. All relays are connected via a short cable to a printed circuit board; 
this way the module is of compact size.  
The OSP- B129 module is supplied and controlled from the OSP 120 via a single 
connector on the OSP- B129 printed circuit board. The connection to the OSP 120 is 
done via one connection cable. 
The OSP- B129 module is equipped with a on board memory to store the necessary 
configuration data of the module. 

Figure 39 Block diagram Module OSP-B129 

When the module OSP- B129 is configured within the OSP 120, a manual operation of 
the module can be performed via the OSP Panel. See chapter 2.2.5 for details. 
For Remote Control operation see chapter 5 and 6 in the operating manual. 
The OSP- B129 is a one-slot module. Within one OSP 120 up to three modules of this 
type can be installed. 
The OSP frame offers a maximum of three slots. If more than one OSP- B129 are 
required, the extension unit OSP 150 must be used. For further information on the 
extension unit OSP 150 see chapter "OSP Driver" in the operating manual. 
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4.3 Graphical User Interface 

The R&S OSP130 can operate in local mode by means of its integrated operating 
elements and display screen. This chapter gives details for the operation of the 
instrument using the graphical user interface (GUI). 

The same graphical user interface is available also for the R&S OSP120 when 
connected to a computer via LAN, and running some browser on this computer. 

The following sections can help you to make efficient use of the OSP GUI of the 
R&S OSP. For additional information on using the OSP Panel see chapter 2.3.

4.3.1 Starting the R&S OSP120 

Connect Monitor and mouse / keyboard to the R&S OSP120 instrument. After power-
on, the instrument is in ready state after about 30 seconds. The graphical user 
interface is available when the R&S OSP120 is connected to a computer via LAN, and 
running some browser (Internet Explorer or Mozilla Firefox for example) on this 
computer. Type the following as URL: 
http://192.168.48.147/vnc (example with OSP default IP address, see chapter 1.9 for 
more information on IP address).  

In the following dialog you are prompted for a password. Type instruments as 
password.  

When finished the start screen displays some information on the equipment, as 
described in the following section. 
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The following keystrokes on the external keyboard correspond to the keys on the front 
panel of the R&S OSP130: 

 key on OSP130 front panel corresponding keyboard key 

MENU  Top level menu  

BACK  up in hierarchy by one menu level  

HOME  Start screen 

CTRL + M 

ESC 

CTRL + H 

cursor keys cursor keys or mouse 

FUNCTION  switching action, if applicable.  

OK  confirms a selection  

STATUS  status information or changes selection of 
a switch for path configuration. 

CTRL + F 

Enter, or mouse click 

CTRL + S 

4.3.2 Starting the R&S OSP130 

After power-on, the R&S OSP130 instrument is in ready state after about 30 seconds. 
When finished the start screen displays some information on the equipment: 

● The field System gives the string rsospvvnnnnnn where vv is the two-digit type 
(e.g. 03 for OSP130), and nnnnnn the serial number of the instrument. 

● Address indicates the IP address (see chapter 1.9. 
● With MAC the instrument’s MAC address is shown. 

Pressing the key  MENU , RESET  or  OK  while the start screen is displayed will then 
go to the top level menu (Main menu). 

Before that start screen or during one of the following operations there might be some 
display of the instrument’s IP address. You may need to press the  OK  key in order to 
close this dialog. 
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4.3.3 General Navigation Operations 

The instruction in this section describe how to access the various menu levels, the 
modules of the instrument, and some general pieces of information. 

With the cursor keys, the appropriate menu function can be selected. 

Selecting Manual Switching and pressing  OK  will display a screen as follows: 

The example here shows an OSP130 connected with a single extension unit OSP150.  

If an extension unit OSP150 is located on F02 to F09, it can be selected from this dialog. 

While the selection to one of the units is made, pressing the  STATUS  key will display 
some information on the unit. See the example. 

Selecting the unit and pressing  OK  will move into the next dialog. 
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Depending on the modules fitted to the unit, the available selections will vary. In the 
example on the left hand side the first slot is equipped with an OSP-B101, the second 
with an OSP-B102, and the third with an OSP-B103. Next to the selected module some 
picture visualizes the capability of the module, in the case of the OSP-B101 indicated 
by a SPDT switch and the count 6x. 

While the selection to one of the modules is made, pressing the  STATUS  key will 
display some information on the module. See the example. 
For completeness, see more examples of module information. 

BACK  From any menu level, this key will bring you one level up in hierarchy. 
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MENU  From any menu level, this key will bring you directly to the Main menu. 

4.3.4 Using the R&S OSP-B101/-B106/-B107/-B111 

After selection of the R&S OSP-B101 module this dialog is opened. 

With the cursor keys one of the six relays can be chosen, indicated by the blue color in 
the relay name. 

Pressing the  FUNCTION  key toggles the relay from NC to NO and vice versa. The 
display of the switch in the dialog is changed accordingly. 

Pressing the key  STATUS  toggles the selection of the relay. 

A selected relay (K11 and K15 in this example) is displayed with a green surrounding. 
All selected relays are taken over into a path configuration. 

A non selected relay is not considered when defining a path configuration. 

The operation as described above applies to further options of the R&S OSP as far as 
the option has got a similar relay configuration. It will apply to the following modules: 

Option Relay configuration 

OSP-B106 3 x SPDT relay with N connectors, 12 GHz,  
3 x SPDT relays with BNC connectors, 900 MHz / 2 A 

OSP-B107 6 x SPDT relay, solid state, 6 GHz 

OSP-B111 6 x SPDT relay, 40 GHz 

Please note that for the module OSP-B106 the relays are numbered from K1 to K6 but 
from K11 to K16 for all other modules. 
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4.3.5 Using the R&S OSP-B102/-B112 

After selection of the R&S OSP-B102 module this dialog is opened. 

With the cursor left/right keys you can chose either relay, and with the cursor up/down 
keys any terminal of that relay, indicated by the blue color. In the example this is 
terminal 1 of relay K1. 

Pressing the  FUNCTION  key closes the chosen relay position. With the Common 
terminal chosen (“C” displayed in blue) the relay is opened. The display of the switch in 
the dialog is changed accordingly. 

Pressing the key  STATUS  toggles the selection of the relay. 

A selected relay (K1 in this example) is displayed with a green surrounding. All 
selected relays are taken over into a path configuration. 

A non selected relay is not considered when defining a path configuration. 

The operation as described above applies to further options of the R&S OSP as far as 
the option has got the same relay configuration. It will apply to the following modules: 

Option Relay configuration 

OSP-B112 2 x SP6T relay, 40 GHz 

OSP-B108 K1 = K11, DC MUX 
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4.3.6 Using the R&S OSP-B103 

After selection of the R&S OSP-B103 module this dialog is opened. 

With the cursor keys any of the 16 output channels can be chosen, indicated by the 
blue color. In the example this is channel 1. 

Pressing the  FUNCTION  key toggles this channel from low (L, dark green) to high (H, 
red) and vice versa. The display of the channel in the dialog is changed accordingly. 

Pressing the key  STATUS  toggles the selection of the channel. 

A selected channel (channels 6 and 7 in this example) is displayed with a green 
surrounding. All selected channels are taken over into a path configuration. 

A non selected channel is not considered when defining a path configuration.  

In addition to the single channel information a total of all 16 channels is shown as 
hexadecimal value. Channel 1 corresponds to the lowest bit, having the value 1, 
whereas channel 16 is the highest bit, having the value 8000. 

Pressing the key  OK  will execute a read command reading the status of all input 
channels. They will be displayed in dark green for low values (L) and in red for high 
values (H).  

In addition to the single channel information a total of all 16 channels is shown as 
hexadecimal value. Channel 1 corresponds to the lowest bit, having the value 1, 
whereas channel 16 is the highest bit, having the value 8000. 
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4.3.7 Using the R&S OSP-B104 

After selection of the R&S OSP-B104 module this dialog is opened. With the cursor 
key either option can be selected and activated by pressing the key  OK . 

4.3.7.1 Setting the Transfer Relays and Reading the Interlock 

In the DPDT Switches case, the following dialog opens. 

With the cursor keys any of the 4 transfer relays can be chosen, indicated by the blue 
color. In the example this is RELAY 1. 

Pressing the  FUNCTION  key toggles this relay into the opposite position, indicated by 
the lines between the connectors. In one position the connections are made between 
connectors 1 and 2 and between 3 and 4. In the other position the connections are made 
between connectors 1 and 4 and between 2 and 3. 

Pressing the key  STATUS  toggles the selection of the relay. 

A selected relay (RELAY 1 and RELAY 2 in this example) is displayed with a green 
surrounding. All selected relays are taken over into a path configuration. 

A non selected relay is not considered when defining a path configuration.  
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Pressing the key  OK  will execute a read command. The status of the interlock, i.e. if 
there is a connection between pins 7 and 15 of the IN / OUT connector, is indicated. A 
green signal shows a closed interlock, a red signal an open interlock. If the interlock is 
closed, a relay also closes a contact between pins 8 and 14 of the IN / OUT connector.  

4.3.7.2 Input and Output Pattern 

When the Digital I/O had been chosen, the following dialog is shown. 

With the cursor up / down keys any of the 5 output channels can be chosen, indicated 
by the blue color. In the example this is channel 1. 

Pressing the  FUNCTION  key toggles this channel from low (L, dark green) to high (H, 
red) and vice versa. The display of the channel in the dialog is changed accordingly. 

Pressing the key  STATUS  toggles the selection of the channel. 

A selected channel (channels 3 and 4 in this example) is displayed with a green 
surrounding. All selected channels are taken over into a path configuration. 

A non selected channel is not considered when defining a path configuration.  

With the cursor left / right key either Read Input or Read Interlock can be selected, 
indicated in blue. Pressing the key  OK  will execute a read command. 

In the case of Read Input the status of all input channels is read. They will be displayed 
in dark green for low values (L) and in red for high values (H). The case of Read 
Interlock reads the interlock status, see chapter 4.3.7.1.
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4.3.8 Using the R&S OSP-B121 

After selection of the R&S OSP-B121 module this dialog is opened. 

With the cursor keys one of the three relays can be chosen, indicated by the blue color 
in the relay name. 

Pressing the  FUNCTION  key toggles the relay from NC to NO and vice versa. The 
display of the switch in the dialog is changed accordingly. 

Pressing the key  STATUS  toggles the selection of the relay. 

A selected relay (K11 and K13 in this example) is displayed with a green surrounding. 
All selected relays are taken over into a path configuration. 
A non selected relay is not considered when defining a path configuration. 

4.3.9 Using the R&S OSP-B122 

After selection of the R&S OSP-B122 module this dialog is opened. 

With the cursor up/down keys you can chose any terminal of that relay, indicated by the blue 
color. In the above example the common terminal C is selected; all six terminals are open. 

Pressing the  FUNCTION  key closes the chosen relay position. With the Common 
terminal chosen (“C” displayed in blue) the relay is opened. The display of the switch in 
the dialog is changed accordingly. 
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Pressing the key  STATUS  toggles the selection of the relay. 

A selected relay (K1 in this example) is displayed with a green surrounding. All 
selected relays are taken over into a path configuration. 
A non selected relay is not considered when defining a path configuration. 

4.3.10 Using the R&S OSP-B123 to OSP-B126 and OSP-B129 

The modules OSP-B123, OSP-B124, OSP-B125 and OSP-B126 combine different 
numbers of SPDT and SP6T as they are used in the OSP-B121 and OSP-B122 
module, respectively. 

The module OSP-B129 houses one terminated SP8T and two SPDT switches. 

The following example is given for the module OSP-B125.  After selection of the this 
module the following dialog is opened. This dialog shows all the available relays of the 
module. 

Selecting the first group of relays, a dialog is opened for relay selection and switching. 

The operation is as usual. With the cursor left/right keys you can chose either relay, 
and with the cursor up/down keys any terminal of that relay, indicated by the blue color. 
In the example this is terminal 1 of relay K1. 

Pressing the  FUNCTION  key closes the chosen relay position. With the Common 
terminal chosen (“C” displayed in blue) the relay is opened. The display of the switch in 
the dialog is changed accordingly. 
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Pressing the key  STATUS  toggles the selection of the relay. 

A selected relay (K1 and K2 in this example) is displayed with a green surrounding. All 
selected relays are taken over into a path configuration. 
A non selected relay is not considered when defining a path configuration. 
The operation as described above applies to the following options of the R&S OSP 
with similar relay configuration. 

Option Relay configuration 

OSP-B123 6 x SPDT relay, 18 GHz, terminated 
1 x SP6T relay, 18 GHz, terminated 

OSP-B124 3 x SPDT relay, 18 GHz, terminated 
3 x SP6T relay, 18 GHz, terminated 

OSP-B126 3 x SP6T relay, 18 GHz, terminated 

OSP-B129 1 x SP8T relay, 18 GHz, terminated 
2 x SPDT relay, 18 GHz 

Please note that for the modules OSP-B121 to OSP-B126 and OSP-B129 all relay 
types SPDT are counted starting with K1 whereas the SP6T types are counted from 
K11 onwards. 

4.3.11 Path Configuration 

A very comfortable way to define the different switching paths required in a test setup 
or in a system is the R&S OSP feature “path configuration”. With suitable dialogs it is 
easy to combine several relay positions of different R&S OSP modules in one path 
information. If path switching is required, only the path configuration is called by its 
name and the switching is performed more or less by a single command. 
See also chapter 2.4 for another approach to path configurations using OSP Panel. 

In this chapter the functions related to path configurations are described based on 
some example. Refer to the previous chapters for selecting switch positions or output 
channel values. 

Choosing a default selection 

To obtain the correct switching for a new path configuration, it is recommended to start 
with a well-defined default selection. There are two possibilities described in the 
following paragraph. 
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Go from the Main menu to the Configuration menu. 
If the number of switches to be included in a path is rather small, it is recommended to 
deselect all switches. This is done by choosing “Deselect all switches”.  

If the number of switches is rather large, chose “Select all switches” instead. Pressing 
the key  OK  will perform the related action. 

Now go back to the Main menu, and from there select “Manual Switching”. In the 
following steps define all relay and output channel settings you want to include in the 
path configuration by using the  FUNCTION  key. Don’t forget to select these relays and 
channels using the  STATUS  key if you have started from a deselected switches 
configuration, or to deselect the ones not required if you have started from a selected 
switches configuration 

A path configuration may consist out of several relays located on different R&S OSP 
modules. Please note that the relay buttons in the corresponding dialogs must be 
selected for all relays which should be taken over in the path configuration. 

Perform the settings of the OSP-B101 module as shown in the second screenshot in 
chapter 4.3.4. This selects K11 to be in NO and K15 to be in NC position. 
Then go back to the Main menu using the  MENU  key, and select the Path Switching menu. 

If no path has been saved so far, the list shown in the dialog only contains undefined 
paths. By default, on an R&S OSP130 there are ten paths which can be defined 
(Panel_path_00 till Panel_path_01).  
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If no path has been saved so far, the list shown in the dialog only contains undefined 
paths. By default, on an R&S OSP130 there are ten paths which can be defined 
(Panel_path_00 till Panel_path_01).  

After pressing the  OK  key (Save being the only possibility when an undefined path is 
marked) the path configuration is stored as Panel_path_00. 

Now mark the Info button using the cursor keys and press  OK . 

The information displayed thereupon contains the two relays included in the path configuration. 
Then go back to Manual switching and select the module OSP-B102. 
Perform the settings of the OSP-B102 module as shown in the second screenshot in 
chapter 4.3.5. This selects K1 to be in position 3. 

Go now back to the Main menu using the  MENU  key, and select the Path Switching menu. 

Channel numbers 

Note that for some modules there might be an offset to be included either way in order 
to convert channel numbers to relay names. For example, channel 1 on an OSP-B101 
corresponds to K11. 

Mark Panel_path_01 with the cursor keys and press  OK . This saves the configuration. 
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Displaying then the related information will lead to the display shown here. 
Note that the K1 setting of the OSP-B102 has been added to the previous one since there 
was no deselect made for OSP-B101. 
Then go back to Manual switching and select the module OSP-B103. 
Perform the settings of the OSP-B103 module as shown in the second screenshot in 
chapter 4.3.6. This selects channel 6 to be low and channel 7 to be high. 
Save this configuration in a similar way to Panel_path_02 and display the related 
information. 

Again, you observe that the new information has been added. 
If a new configuration needs to be independent from the previous one, you should use 
the Configuration menu first in order to deselect or select all switches. 
In any case, it is good practice to verify the settings by close inspection of the saved 
path configuration. 
Besides the possibilities for defining a path configuration and to display the information 
related to this configuration, there are two more actions one can do from the path menu. 

When marking an existing path and choosing the Set button, pressing  OK  will switch 
all relays and channels related to this path configuration. 
Note that performing the switching will not change which switches are selected. Only 
the state of the switches of the path configuration will be set as desired. 

When marking an existing path and choosing the Delete button, pressing  OK  will 
remove this path. 

Names of path configurations 

As seen in this chapter, the paths which can be chosen for saving path configurations 
are the fixed ones (Panel_path_01 etc.) provided on the GUI. 
Using the OSP Panel, see chapter 2.4, free names can be given to configurations. 
Within the GUI it is possible to save new configurations onto these names as well, and 
also the other functions like Info, Delete and Set are available. 
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4.4 R&S OSP Switch Cycle Counter 

The R&S OSP is designed with a switch cycle counter. 
Although the mechanical relays used in the R&S OSP modules are selected with 
respect to high life time, it is recommended to count the switching cycles to have an 
overview on the instrument use and to replace the relays in time. Please note that the 
Switch Cycle Counter function is disabled for all solid state relays. 

R&S OSP Switch Cycle Counter 

The cycle counter is active for all OSP modules with mechanical relays. For OSP 
modules with solid state relays the switch cycle counter is not activated. 

The information on the switching cycles is stored on each of the R&S OSP modules. This 
way the modules always keep the actual information even when exchanging a module.  

R&S OSP Switch Cycle Counter 

The cycle counter state is not continuously saved on the flash memory of the 
R&S OSP modules but only in regular intervals. The switch cycle counter only is 
foreseen to be read for maintenance and service purpose. 

The Switch Cycle Counter State can be read using the OSP Panel application.  

Operating the OSP Panel will show a button “Fetch Counters” for all OSP modules 
where this function is applicable. See the following example for OSP-B101 module: 
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The numbers at each relay label (K11 to K16) show the cycles, the relays already have 
been switched to NO and NC position, respectively. 

Selecting this button will read the actual state of the switch cycle counter. 

Pressing this button will exit the dialog. 

R&S OSP Switch Cycle Counter 

Note that the OSP switch cycle counter state is stored on the corresponding switch 
module on-board memory. To reduce the write operations for the on-board memory, 
the cycles are stored on the following events: 

● each 60 minutes  

● every 1000 cycles 

● on each “Fetch Counters” command (only if counter state has changed) 
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4.5 R&S OSP Selftest 

The R&S OSP provides a basic selftest procedure on module level. The selftest is 
primarily intended for production and service purposes; it is not needed during normal 
operation of the instrument. The following description serves as a general overview.  

4.5.1 Selftest via OSP Panel 

A selftest can be performed for the R&S OSP via the OSP Panel. See chapter 2 for 
information on the installation and operation of the OSP Panel application. 

The selftest result reflects the current instrument status and checks if all the hardware 
as shown in OSP Panel module catalog is correctly initialized. 

The selftest does not execute special hardware tests. 

The selftest is started as follows: 

► Select >Utility >Self Test … in the OSP Panel. 

The selftest is started immediately and with positive result, the following message will appear: 

Press OK to exit the Selftest Utility. 

4.6 R&S OSP Configuration Check 

The R&S OSP and the installed modules all are equipped with on-board memory 
containing the actual device and module data. These data are primarily intended for 
production and service purposes. 

4.6.1 System Info via OSP Panel 

The system information can be read out of the R&S OSP via the OSP Panel. See 
chapter 2 for information on the installation and operation of the OSP Panel application. 

The system info can be read as follows: 

► Select >File >System Info … in the OSP Panel. 

The system information is read from the R&S OSP hardware and the following text 
file is opened and displayed: 
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If any paths are defined for the R&S OSP, they are listed under [Path List]. 
The name of the path is indicated together with the relay setting related to the path. 
Close the Notepad to exit the system info utility. 

System Info: 

The text file containing the System information is stored with the file name ospSystemInfo.txt in 
the installation directory of the OSP Panel (default directory: C:\OSP Panel). 

Each time the system info utility is started at the OSP Panel, this file is overwritten with 
the actual data.  

4.7 SCPI Read/Write CommandsHeading 2 

As an additional feature, the OSP Panel allows a direct communication with the 
R&S OSP via SCPI commands. This additional feature is foreseen for debug purpose 
and requires to be familiar with SCPI commands of the R&S OSP. Refer to the section 
on remote control (chapters 5 and 6 in the operating manual) for further information. 

For direct communication with the R&S OSP via LAN interface proceed as follows: 

1. Start the OSP Panel. 

2. Select >Utility >Read/Write … in the OSP Panel. 

The following dialog will appear: 
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The command to be written to the R&S OSP is entered in the upper text field. The 
above example sends the identify command to the R&S OSP as soon as the Write 
button is pressed. 

After pressing the Read button, the answer is read from the R&S OSP. In the above 
example the identification of the R&S OSP is read back and displayed.  

Having entered the SCPI command in the text field next to this button, the command is 
sent to the R&S OSP as soon as this button is pressed.  

If the command sent to the R&S OSP is a query command expecting an answer from 
the R&S OSP, the answer can be read by pressing the READ button. 

SCPI Read/Write Commands 

This function is not required for operation of the R&S OSP. It is foreseen as additional 
feature for test and debug purpose. The use of SCPI Read/Write Commands requires 
knowledge of the R&S OSP remote control commands. 
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4.7.1 OSP Temperature Read command 

The OSP design with I2C interface and memory on each module has the utility to read 
the temperature on it’s interface.   

Read OSP module temperature 

Note that this utility makes use of the module interface function. The read-back of the 
module temperature is just for information and is not specified. This utility may be used 
for example to examine the temperature conditions of the R&S OSP when the unit is 
operated inside a rack. 

The read the temperature from the OSP modules, the following SCPI command is sent 
to the OSP: diag:service:sfun? F01,"temp2 0" 

F01 is the OSP frame 1 and temp2 the command to read the temperature. 

The last digit in the above string has the following meaning: 

0 = OSP Mainboard 
1 = OSP Module interface 1 
2 = OSP Module interface 2 
3 = OSP Module interface 3 

The SCPI command can be sent via the application OSP Panel, >Utility >Read/Write 
as shown in the below example. 

Note that for the above function the corresponding module must be configured in the 
OSP; if the module interface in not available, an error message will appear.  
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